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1.  About This Book  
 

This book is a very light-weight introduction into the exciting world of the “Simulation Driven Design Process”. It is meant to 

give pupils, undergraduate students and maybe even designers new to Computer Aided Engineering CAE a “taste”, a first 

idea on how simulation, especially conceptual design (simulation) works.  

  

The tool of choice used in this book is Altair Inspire®. Inspire enables design engineers, product designers, and architects 

unfamiliar with numeric simulation, to make optimal use of the material by placing it only where needed to meet structural 

requirements. With INSPIRE, you will be able to:  

  

• Create, modify, and de-feature solid models  

• Generate design concepts that are not only structurally efficient but also manufacturable by choosing your 

manufacturing process,  

• Customize your material,  

• Choose your optimization options: loads, displacement and stress constraints, objectives (e.g. maximize stiffness or 

minimize mass),   

• Surface smoothing of the optimized concept geometry  

• Analyse the performance of concepts generated by the software using finite element calculations.  

  

Depending on your experience you may feel lost by reading the explanation on what Inspire is. Don’t’ worry, we’ll explain all 

these terms in this book.   

Please note that a commercially released software is a living “thing” and so at every release (major or point release) new 

methods, new functions are added along with improvement to existing methods. As such, there may be some differences 

between what you see in the videos and the latest version of Inspire. However, we believe that these differences will not 

distract you from using this guide as an effective learning tool.   

Any feedback helping to improve the quality of this book would be very much appreciated.   

  

Thank you very much.  

Dr. Matthias Goelke  

On behalf of the Altair University Team  
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1.1. Model Files  

The models (geometry) referenced in this book can be downloaded using the link provided in the exercises, respectively. You 

can download the Inspire model files from HERE These models are compatible with the latest version.  

 
 

1.2. Software 

Obviously, to practice the “Simulation-Driven Design Process” you need to have access to Inspire. As a student, you are 

eligible to download and install the free Student Edition 

 

https://altairuniversity.com/free-altair-student-edition/ 

Note: From the different software packages listed in the download area, you just need to download and install Inspire 

 

1.3. Support 

In case you encounter issues (during installation but also how to utilize Altair Inspire) post your question in the moderated 

Support Forum:  https://community.altair.com/community 

It’s an active forum with several thousands of posts – moderated by Altair experts!  

 

1.4. Free eBooks  

In case you are interested in more details about the “things” happening in the background we recommend our free eBooks. 

Currently, we offer more than 16 different titles for free.  

                                        

http://altair.com/
https://www.altair.com/contact-us/
https://altairuniversity.com/wp-content/uploads/2019/05/Inspire_eBook_Tutorial_Modelfiles.zip
https://altairuniversity.com/wp-content/uploads/2019/05/Inspire_eBook_Tutorial_Modelfiles.zip
https://altairuniversity.com/free-altair-student-edition/
https://community.altair.com/community
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https://altairuniversity.com/free-ebooks-2  

  

    

1.5. Learning & Certification Program  

Many different eLearning courses are available for free in the   

• Learning & Certification Program 

https://certification.altairuniversity.com/   

  

For instance, you may find this eLearning course helpful:  

• Learn Mechanics of Solids Fundamentals 

 

https://certification.altairuniversity.com/course/view.php?id=66  

 

This course is to introduce the subject of mechanics of solids with a focus on theory. Of course, there is also an 

eLearning course about Inspire available. 

http://altair.com/
https://www.altair.com/contact-us/
https://altairuniversity.com/free-ebooks-2
https://altairuniversity.com/free-ebooks-2
https://certification.altairuniversity.com/
https://certification.altairuniversity.com/
https://certification.altairuniversity.com/course/view.php?id=66
https://certification.altairuniversity.com/course/view.php?id=66
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• Learn Conceptual Design with Inspire 

 

                        https://certification.altairuniversity.com/course/index.php?categoryid=47  
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1.7 Disclaimer  

Every effort has been made to keep the book free from technical as well as other mistakes. However, publishers and authors 

will not be responsible for loss, damage in any form and consequences arising directly or indirectly from the use of this book.  

© 2021 Altair Engineering, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, or 

translated to another language without the written permission of Altair Engineering, Inc. To obtain this permission, write to the 

attention Altair Engineering legal department at:  

1820 Big Beaver, Troy, Michigan, USA, or call +1-248-614-2400.  
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2.  General Remarks About Simulation  

If you search the internet for the term “simulation” you’ll come across many results. In my case more than 200,000,000 search 

results were listed which is a pretty impressive number. So, what is simulation about?  

The online dictionary (http://www.dictionary.com/browse/simulation) provides the following explanations:  

Simulation (noun)  

1. imitation or enactment, as of something anticipated or in testing.   

2. the act or process of pretending; feigning.   

3. an assumption or imitation of a particular appearance or form; counterfeit; sham.   

4. Psychiatry. a conscious attempt to feign some mental or physical disorder to escape punishment or to gain a desired 

objective.   

5. the representation of the behavior or characteristics of one system through the use of another system, especially a 

computer program designed for the purpose.   

 

A bit more detailed explanation/description is the one you may find in Wikipedia (https://n.wikipedia.org/wiki/Simulation; July 

25, 2017):  

 

Simulation is the imitation of the operation of a real-world process or system over time. The act of simulating 

something first requires that a model be developed; this model represents the key characteristics, behaviors 

and functions of the selected physical or abstract system or process. The model represents the system itself, 

whereas the simulation represents the operation of the system over time.  

  

Simulation is used in many contexts, such as simulation of technology for performance optimization, safety 

engineering, testing, training, education, and video games.   

  

Key issues in simulation include acquisition of valid source information about the relevant selection of key 

characteristics and behaviors, the use of simplifying approximations and assumptions within the simulation, 

and fidelity and validity of the simulation outcomes. …..  

  

The following series of examples may be helpful to better understand the above definitions. However, we admit that the 

simulation examples shown are kind of special as they do not represent the typical use cases. Nevertheless, they may excite 

you and provide you a first idea on what can be done. 
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Slingshot Topples Cans  

 

 

https://altair-2.wistia.com/medias/15uk0lb9u4  

  

The slingshot simulation was carried out by our colleague Magnus Lindvall / Sweden. The ball has a maximum velocity of 18 

m/s (7 m/s after impact with cans) and hits the targets quite successfully - as you can see in the animation. To better visualize 

the results, i.e. to make the simulation look like a real-life test, the simulation results are rendered (i.e. the process of 

generating photorealistic images/animations from a 2D or 3D model)   

Simulation was carried out with RADIOSS, results visualized and rendered in Evolve (both products are part of the CAE 

software suite HyperWorks).  

A few more “entertaining” simulation projects – don’t take them too seriously.  

  

Banana Peel “Project”  

Our colleague Fredrik Nordgren / Sweden simulated a new way on how to peel a banana ...  

           

  

        

                     

 

 

 

 

         

 

https://altair-2.wistia.com/medias/owtu9nflt5  
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Ford Raptor vs Caterham Crash  

Interested to see what happens when two trucks crash into each other- especially when they are not made from steel and 

aluminum? Our colleague Magnus Lindvall & team in Sweden worked on this special simulation project to find some 

“answers”. The animation below illustrates how the trucks will perform in case they are built out of “bricks” (like LEGO toys).  

 

 

https://altair-2.wistia.com/medias/p6uokkft0l  

  

 

Free spin Simulations of a Fidget Spinner  

Fidget spinners are quite popular these days. These fun toys have swept elementary and middle schools by storm!   

       

Our colleague Michael Barton had a closer look at the Fidget Spinner. The model shown in the images was designed and 

simulated using the HyperWorks product suite, including Altair Evolve (geometry and rendering) and the general purpose. 

  

http://altair.com/
https://www.altair.com/contact-us/
https://altair-2.wistia.com/medias/p6uokkft0l
https://altair-2.wistia.com/medias/p6uokkft0l


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       13 

  

  

       

  

Computational Fluid Dynamics (CFD) solver, AcuSolve (i.e. in CFD problems the fluid flow is analyzed.). The CFD analysis 

was conducted to demonstrate how a jet of air particles interacts with the rotating spinner. The simulation captures the surface 

air flow, near field air disturbances and the surface pressure on the spinner at a scale too small to obviously notice.   

 

  

 

 

2.1 The CAE Driven Design Process  

In here (in the book) the term “simulation” refers to “virtual product design”, meaning that a computer model (a virtual model of 

the product) is investigated to better understand how the product would perform. For instance, look at your cell phone. It may 

happen that it drops/ falls off the table. The question is: Will it break?  

 

http://altair.com/
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Finite element model of a cell phone  

 

Another example is shown in the image below: Two cars crash into each other. The question is: Will the passengers survive?   

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Finite element model of a car crash 

  

The computer models allow you to understand how the cell phone or the vehicles will perform. For instance, the simulation 

results may tell you whether the casing of the cell phone may fracture, or whether parts of the car engine may intrude the 

passenger cell, and so forth.  

Based on the simulation results, the virtual product may be modified “quickly” until it meets given requirements. This 

“traditional” process is depicted in the image below:  

            

http://altair.com/
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The initial design geometry (CAD) provided by the designer serves as the basis of the simulation model. Once the virtual 

model performs as expected, for instance deformation of the structure due to applied loads meets specified product 

requirements, a prototype is built and tested. The final test of the prototype then hopefully shows acceptable results. If not, 

one needs to start anew. A pretty bitter experience, and costly as well.  

  

“In the past we would add or take away material in certain areas of the component and then do a structural analysis 

to see if the component would meet the criteria. With Altair Inspire we don’t have to go down this path anymore - 

we just define the design space, add load and boundary conditions, and the optimization produces a design that 

usually fits the criteria,” Uwe Kasper, design engineer at LEIBER.  

  

What do we learn from it?  

• Analysis is used to evaluate designs   

• Repetitive analysis leads to better design  

• Engineering experience needed to derive design changes  

Despite the advantage’s simulation offers in this process (testing different variants/designs) the “bottleneck” is that the design 

and likely required design changes strongly depend on the knowledge, experience, and skills of the designer (without criticism 

of the designers).  

This challenge (or situation) quite often is reflected by the 80/20 rule.  

 

What does it mean?   

Experience shows that, about 80 % of the final product weight is determined by the designers’ first concept. Of course, during 

the project, this first concept is fine-tuned to achieve better results. However, the overall concept remains pretty much as it is.   
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This situation is depicted in the image above: during the start of the project one typically lacks knowledge (or experience) and 

faces many different options (possibilities; shown in black) - so in a worst-case scenario one starts with a sort of trial and error 

approach. However, in the same instance, the “hourglass” starts running.   

 While working on the project, our knowledge (blue) about the product is increasing. However, the time available to complete 

the task is becoming less and less.   

So, the first concept is crucial. Truly, a difficult situation.   

Especially, …  

• What if you don’t have experience with this type of design?  

• What if there are no similar or previous designs to reference?  

• What if the similar design doesn’t scale for the new configuration?  

• What if previous designs were never optimized for weight?  

• What if you have many loading scenarios (“load cases”) to simulate?”  

• What if you have limited time to make design changes?  

• What if your engineering judgment leads you down the wrong path?  

• What if you don’t know where to start from?   

• …  

In fact, the situation is even worse. While trying to get the job done as good as possible, you are also competing with others - 

regardless whether you are from High school, University (e.g. as a member of a student competition team participating in one 

of the famous FSAE, BAJA, Global Solar or the Shell Eco Marathon challenges etc.) or from Industry.  

Of course, competition adds more excitement to what you are doing, but it may also give you some headache.  
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For instance, look at the challenges the automotive industry faces currently:   

“vehicles have to become lighter to reduce fuel consumption and CO2 emissions, yet they must be safe and reliable. In 

addition, manufacturers have to offer their products at competitive prices. To embrace the lightweight requirements brought 

upon them, new design methods and material have to be included in the development process to ensure lighter, yet stiff and 

safe components to contribute to the overall performance of the vehicles. Over the years, automotive vehicles have become 

heavier – this is mainly due to new systems that increase safety, comfort, and driving experience. This is partly due to the fact 

that for many years, weight reduction was not a primary development goal.  

The weight spiral now has to be turned around, and cars and commercial vehicles have to become lighter. Therefore, the 

automotive industry is seeking new approaches and methodologies in the development and manufacturing process to realize 

optimal lightweight structures (from Customer Story Leiber Group.  

http://www.solidthinking.com/ExploreStories.aspx?item=Stories&category=Explore) This is the point where the “CAE Driven 

Design Process” as advocated by Altair for years (and our tools) comes into play.  

The proposed (and meanwhile broadly adopted) process is slightly different than the “traditional” one from above - but yields 

typically dramatically better results. We therefore “dare” to ask our users to “Design the Difference”.  

 

 

 

This process starts with a concept design coming from either a topology optimization, i.e. material is removed from the 

structure in load (force) free areas, or topography optimization. The latter method creates patterns of beads on thin walled 

structures to increase its strength (more details about topology and topography optimization can be found further below).  
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Then the virtual test is carried out to evaluate the design, for instance to check whether the resulting deformation due to 

applied forces is within the allowed limits.  

If the results are acceptable then a prototype is built and tested. Overall, this process not only leads to very material efficient 

structures but allows you to get there faster.  

The following video provides an illustrative summary of the above:   

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://altair-2.wistia.com/medias/btoulwzz2o  
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What do we learn from it?  

• Concept optimization (right at the beginning of the project) suggests/provides material efficient geometries   

• In the design phase, the designer takes advantage of the proposed geometry  

• (i.e. the concept design provides the designer “guidance”)  

• Analysis (virtual test) is used to evaluate the design  

• More innovative designs (material efficient), shorter design phase (= saves money), higher competitiveness  

At the end of the design process you may look at such amazing and inspiring structures:   

  

  

  

  

  

  

  

 

 

 

 

 

Summary:  

Because of economic reasons simulation and the “Simulation Driven Design Process” has found its way into almost all 

industries such as Automotive, Aerospace, Defense, Consumer Products, Medical, Oil and Gas, Architecture and many 

others.   

In 2016 CIM data (the leader in PLM Education, Research, and Strategic Management Consulting; 

http://www.cimdata.com/en/) stated:   

“We are truly in the era of simulation-driven engineering — an era where simulation can help synthesize and define the 

physical design, rather than simply evaluate and validate a completed design.”)  

What does it mean for you and your future?  

Of course, we don’t know the future either (which is good though) but it is to be anticipated that industry will be / is keen on 

hiring well educated young engineers with CAE knowledge…  
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2.2 Examples from Industry & Academia  

  

Volkswagen Multivan Bracket Re-Design  

Several years back VW redesigned a bracket used in their Multivan. In the image below the old (initial) design (in gray color) is 

shown. The interior of the redesigned bracket looks very different (Note: the outer contour of the bracket had to remain the 

same).  

 

Base (initial) design   

    2.000g  

 

 

 

 

 

 

 

New design  

    1.550g    
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 Take a second and notice the differences between the two designs. The Simulation Driven Design Process helped not only to 

reduce its mass by 23%, it shortened the design process, too.   

Very impressive, isn’t it? Would you have come up with a similar design?  

  

Hyper mileage Design with Altair Inspire   

(University of Michigan Super mileage Team)  

 

 

Each spring, teams from universities across the country come to Houston, Texas to compete in the Shell Eco Marathon 

competition. The goal is simple: produce a vehicle that gets the best fuel economy. Often with little more than a lawn mower 

engine and some spare bike parts, these teams regularly reach 2000-3000 miles per gallon (MPG).  

One of the main ways to get higher fuel economy is to reduce mass as much as possible; less weight = less energy to push 

the car = less fuel used. Pretty simple concept, but as undergrads the optimal design is not always apparent at first glance. 

While struggling with this problem I happened to be introduced to Altair Inspire by a co-worker at Altair. I immediately knew 

that this was the solution for our team. The software was very easy to learn and using manufacturing constraints resulted in 

shapes that we could easily manufacture on our limited equipment.  

I set about redesigning some of our chassis components with Altair Inspire. Specifically, I wanted to optimize the structure that 

connected our front wheels to the main carbon structure of the car. Some pictures of the parts in the software interface are 
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shown below. The extrusion constraint allowed me to design parts that can be almost completely made on the water jet, a 

huge time saver for a team as small as ours.  

 

The final iteration of the part designs took some other design constraints into account, but the basic shape generated was 

maintained. In total, the redesign reduced the mass of the assembly from 1344 g to 407 g, a reduction of almost 70%!  

 

 

For more information on the team, please visit http://umsm.engin.umich.edu/ or email johnril@umich.edu. The entire report 

can also be viewed at:   

http://innovationintelligence.com/hypermileage-design-solidthinking-inspire/   

  

Leiber Group – Customer Story  

In a typical use case, LEIBER engineers receive an existing component from their customer. Using the existing part as a 

starting point, the engineers design a new geometry to substitute the former component.   

Another approach used by LEIBER is the creation of an entirely new component, without relying on previously created 

geometries. Here too, Altair Inspire is used upfront in the project’s design process to create a new structurally efficient design. 

A recent project at LEIBER required its engineers to redesign a component for a commercial vehicle. The previous part, a 

suspension beam, was made of cast iron. In this case, the customer required a lighter, yet equally strong new component. To 
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design this part, LEIBER engineers used Altair Inspire and a new material, AluXtrem®, a high tensile forgeable alloy, also 

developed by LEIBER. In combination, Inspire and the new material received significant lightweight results.  

 

Image: courtesy of LEIBER Group  

 

The resulting new component was more than 50 percent lighter than the previously used cast iron component, and a lead-time 

reduction in manufacturing and testing enabled a more economical production process. The solution was recently awarded 

with the EUROPEAN ALUMNIUM AWARD.  

Read the entire story at:  

http://www.solidthinking.com/ExploreStories.aspx?item=Stories&cat egory=Explore Skateboard By 3D Systems  

Recently, the Cooper Hewitt – Smithsonian Design Museum in New York approached 3D Systems with an opportunity to 

participate in an exhibit. The collaboration centered around creating an exhibit to highlight the new processes in which objects 

are being made and designed using innovative software and new manufacturing methods. After some initial brainstorming, the 

team at 3D Systems determined multiple products that it felt should be displayed in the exhibit. One of the products that was 

decided upon was a 3D printed, structurally efficient skateboard. The goal here was to improve upon a product that has been 

fairly unchanged for many years. The team at 3D Systems wanted to see how they could change the way a skateboard is 

designed and produced.  

Knowing that they wanted to create a skateboard lighter than others on the market, 3D Systems used Altair Inspire to optimize 

the deck and trucks of a traditional skateboard design. Inspire helped 3D Systems to generate the ideal skateboard shape that 

was used to create the final design.   
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Underside of 3D printed skateboard  

  

“Future plans include using Inspire to redesign and print the wheels of the skateboard. We are also working on a second 

version of the skateboard that will be printed using glass filled nylon. This will be stiffer than the current board, which due to its 

material is a bit flexible. Other than the slight flexibility, the board rides just like a normal skateboard, but it is much lighter. The 

entire assembly weighs just 3.4 pounds, over 50% lighter than a normal board.”  

Read the entire story at:   

http://www.solidthinking.com/ExploreStories.aspx?item=Stories&cat egory=Explore   

Elbflorace Electric Formula Student Team  

 

 

Image: courtesy of Elbflorace  
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The challenge to face - Design and manufacture a new Formula Student steering column mount  

“The current steering column mount had four different areas that were at different angles to each other, because of this, it was 

extremely difficult to produce with a 5axis milling machine. The solution to produce this part consisted of four different milled 

aluminum parts that were all bolted together. We also discovered other parts that could ultimately be redesigned for additive 

manufacturing like the uprights, but we selected the steering column mount as we felt that with this part, we could make the 

largest performance and weight improvements.”  

 

               

Original steering column assembly  

  

Knowing that the goal was to produce the part using electron beam melting, Michael and Lucas knew that they would have 

great freedom when designing the part. Michael noted, “Electron beam melting has a huge advantage over other 

manufacturing methods, it allowed us to be quite free with our design as there are very few design constraints.” With the 

knowledge that both Michael and Lucas had of Inspire, they determined that it was the ideal tool to perform both the 

optimization, as well as refinement and final preparation for manufacturing. Lucas noted, “Inspire allowed us to determine the 

ideal material layout for the part and the PolyNURBS tools enabled us to get from the optimization to manufacturing extremely 

quickly. I would say that the entire part refinement process took only 5-7 hours, which is extremely quick.” 
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       Rendering of new steering column after refinement with PolyNURBS  

 

Results  

• Redesign of steering column mount to be produced with additive manufacturing (electron beam melting)  

• Reduction in number of necessary parts from four to one  

• 35% weight savings on steering column mount (330 g down from 500 g)  

• 5x increase in stiffness on new part  

  

Inspire optimization of steering column  
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• 50% reduction in overall design time  

• 90% less wasted material with new manufacturing process  

  

The story above is just an excerpt of the entire article:   

http://www.solidthinking.com/ExploreStories.aspx?item=Stories&category=Explore  

Before we go ahead practicing and exercising the “Simulation Driven Design Process” let’s have a glimpse on what is 

happening in the background, meaning within the software (without talking about mathematics).   
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3. The Finite Element Method – A One Minute 

Introduction  
  

The simulation technology presented in this book is based on the Finite Element Method (FEM). It was first developed over 60 

years ago as a method to accurately predict the reaction of complex parts to various inputs (for instance forces or 

temperatures acting on the part). FEA in its infancy was limited to large scale computing platforms but the development of 

powerful personal computers, combined with intuitive software packages such as solidThinking and HyperWorks, has brought 

FEA to the engineer’s desktop, to you.   

In the Finite Element Method, the geometry is subdivided into small but regular areas or volumes which are called Finite 

Elements. In other words, the volume or the surface will be represented by thousands or even millions of elements eventually.   

These elements may have different shapes (configurations):  

 

                               

                                    3 noded tria         4 noded quad            4 noded tetra        8 noded hexa  

  

  

The Finite Elements are connected at nodal points with each other as depicted in the next image:  

 

                      

Brown: finite elements, yellow: connecting nodal points  
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For the analysis, one needs to assign material properties such as the Young’s Modulus E (elastic modulus), which defines the 

relationship between stress s (force per unit area) and strain e (proportional deformation) in a material (σ=E*ε), to the 

elements. As we are interested to see how the structure performs if subjected to, for instance forces, these forces need to be 

applied to the model. As the applied forces will move (accelerate) the model in space, some parts of it need to be constrained 

(fixed).  

This may also be formulated (or expressed) as:  

In mechanics, we define a steady state as the state of a system that is in equilibrium. Equilibrium means the loading in the 

system is balanced so that the system remains at rest (V=0). This equilibrium system is called static analysis. When solving a 

static analysis, all finite element solvers will solve the equation  

Kx = f 

where:  

 K: is the global stiffness matrix  

 x: is the displacement vector response to be determined  

f: is the external forces vector applied to the structure  

All the math – calculation of displacements, deformation and stresses are then carried out with respect to every single element 

(or node). It all happens while you are waiting for the analysis run to be completed.  

Note: A completed simulation run doesn’t guarantee that the results are correct. The Finite Element Program is a “number 

cruncher” only. Errors (i.e. simulation run is aborted) are reported if the mathematics can’t be solved. For instance, the 

thickness of a plate is defined to be “0” and so on ...  

Another very important type of analyses (also available in Inspire) is called normal and buckling modes analysis  

When a structure is subjected to excitations from a dynamic load like an unbalanced rotating device or fluctuating airflow, it will 

vibrate. When you design a structure, you want to make sure it doesn’t vibrate in a way that causes discomfort or leads it to 

perform improperly.  

Any given structure will tend to vibrate at discrete frequencies. For instance, if you hit the end of a cantilever beam with a 

hammer, the beam may start to vibrate at 200 Hz, and then after some time it will abruptly drop down to, for example, 180 Hz 

and continue to vibrate at that lower frequency. As the beam loses energy, it will vibrate at progressively lower frequencies, 

making discrete jumps in frequency as it goes. These discrete frequencies that a structure tends to vibrate at are called the 

natural frequencies of the structure.  

When a structure is vibrating at one of its natural frequencies, it also vibrates in a shape at that frequency. For instance, when 

the beam mentioned above is vibrating at 200 Hz, it may be bending up and down like a diving board. As it drops to the next 

lower natural frequency, 180 Hz, it may switch to a back and forth wagging motion. As it drops again in frequency, the end of 

the beam may scribe a circle in space or the beam may take on the shape of an oscillating sine wave. These displacement 

patterns are called mode shapes.  

The term normal mode is used to describe a characteristic frequency and its associated mode shape.  

In case you want to learn more about the Finite Element Method, you may find the following free eLearning courses 

helpful:  
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Learn Theory of Finite Elements Fundamentals  

 

                          

                               https://certification.altairuniversity.com/course/view.php?id=67  

  

This course is to introduce the subject of Finite Element Analysis (FEA). In this course, you can see the basic theory of Finite 

Element Method applied on linear static cases. These are the topics: Analytical method, application of Finite Element Method, 

element stiffness matrices, interpolation functions, element assembly, and solving an example.  

  

                                                      

                  https://certification.altairuniversity.com/course/view.php?id=79  

 

The goal of this course is to present the main Finite Element Analysis concepts that are useful to evaluate results and interpret 

execution errors, to provide the analyst more skills to perform high quality analyses.  
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Learn Mechanics of Solids Fundamentals   

 

            

https://certification.altairuniversity.com/course/view.php?id=66   

  

It is important (at least helpful) to have a basic understanding of what stresses, deformation and strains are. This course is an 

introduction into the subject of mechanics of solids with a focus on theory.  

After this very short and very simple introduction into the Finite Element Method, it is time to look at the individual working 

steps. This leads us right into the next chapter:  

The Finite Element Analysis Procedure.  
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4. The Finite Element Analysis Procedure   

 

1. Import the geometry (for instance, created in a Computer Aided Design CAD package). Of course, you can create the 

geometry in Altair Evolve or Altair Inspire as well. Please see the chapter “Geometry Building And Editing” for more 

details.  

 

 

 

 

 

 

 

 

 

 

Imported geometry 

   

2. Assign material properties (you can choose the material of interest from the material database contained in 

Inspire. Naturally, you can define materials on your own, too).  

 

                                         

Material database available in Inspire  

 

3. Apply loads (i.e. forces, temperature or pressure - whatever is going to act on the product later) and fix (constrain) 

the model in space so that the applied loads do not move (accelerate) the ENTIRE model away (which is also called 

rigid body motion)  
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Model (geometry) with loads and constraints applied 

  

Note: Depending on whether your model consists of different parts (you may also call it components) and whether these parts 

are supposed to move relative to each other “Contacts” will be added automatically  

 

              

    Contacts between different parts / components of the model 

 

4. Run the simulation. Inspire will ask you whether the simulation run should be carried out “Fast” or “More accurate” 

(use “Fast” to test your model). The size of the Finite Elements used are determined automatically. The same 

accounts for the type of elements being used.  
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Run options  

 

5. Start the simulation run  

6. Visualize the results and try to understand “what you see”, e.g. are the result values shown reasonable (e.g. your 

model is 100 mm long and you see a deformation of 2000 mm would indicate something is wrong; or you have a 

perfectly symmetric model but the results reveal asymmetry); animate the results, i.e. the model starts to 

swing/vibrate (e.g. your model is loaded in vertical direction only but the animation shows (small) lateral motions 

would indicate that the way the structure was pinned/ fixed or the way loads were applied are not correct).  
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Simulation results (here displacements) 

 

Apart from displacements stresses are very important (i.e. the stresses tell you whether the part can sustain the loads at all). A 

bit more information about the kind of results you are looking at is provided in the Appendix “How To Interpret Finite Element 

Analysis Results”.  

Something to keep in mind:  

The above working steps seem to be straight forward. However, “things” may seem easier (sometimes more difficult) than 

they are. Literally, every step depicted above comes along with questions. Naturally, answers to these questions are helpful.  

Geometry - Do you need to keep all the details (features) contained in the geometry file? Can the geometry be simplified? For 

instance, a thin metal part with a thickness of 5 mm may be modelled as a solid structure or as a shell structure. In the latter 

approach a so called midsurface model may be derived from the solid geometry to shorten computation time ...  

Material - Typically we use a single value for the Young’s Modulus, density etc. Does this really reflect reality? What if the 

material properties vary let’s say by +/- 10%?   

Finite Element Mesh - Inspire takes care of meshing (by default). You still can change element size and choose between 1st 

and 2nd order elements (see Exercise “Plate with A Hole”). However, you need to rely on the given element quality (i.e. that a 

quad element looks like a quad).  

Loads and constraints - The crucial questions are: where are the loads (forces) coming from, what are their direction, 

magnitude, where to apply the loads? Similar question relates to the constraints (fixes). How to fix the geometry so that 

translations and rotations of the entire model do not occur - to simply pin (fix) the model everywhere is certainly not the best 

answer. Fixing every (too many) nodes artificially stiffens the structure as the constrained nodes would resist any deformation 

(absolutely rigid). Recommendation - Ask colleagues for help and advice. You don’t need to reinvent the wheel.   

  

http://altair.com/
https://www.altair.com/contact-us/


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       36 

  

  

5.  Basic Interaction with Inspire  
 

Before we exercise the steps, we need to have a basic understanding on how to use the program at all. In the following we 

summarize what you need to know about:  

• Graphical User Interface  

• File Management (in every simulation different file are created)  

• How to select and edit objects  

• Units and Measurements.  

  

5.1 Graphical User Interface  

 

Learn how to “move” and “dance” with Inspire, i.e. learn more about the graphical user interface. In addition to the selected 

topics included in this chapter you’ll find more information about, for instance, snapping, surface modeling in the Help 

Documentation of Inspire.  

Note: The video series below is based on Inspire 2016. The overall (working) philosophy hasn’t changed  

 

Watch - Application Overview   

 

  

https://altair-2.wistia.com/medias/s5al4q00ve (duration 2’:04) 
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Watch - Modeling Window   

 

         

https://altair-2.wistia.com/medias/gxbqlxu6qw (duration 2’:06)   

 

Watch - Geometry Ribbon   

 

 

https://altair-2.wistia.com/medias/cha93op0ph (duration 2’:03)  
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Watch - Structure Ribbon   

 

 

https://altair-2.wistia.com/medias/gkorkq930a (duration 2’:29)  

  

 

Watch - Model Browser   

 

 

https://altair-2.wistia.com/medias/9cda4gy0ex (duration 2’:11)  
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5.2 Mouse Controls   

Mouse controls are used to pan, zoom, and rotate the model.  

                 

 

Note: You can customize the mouse button/keystroke combinations used to pan, zoom, and rotate so they match other 

commonly used CAD applications using the File > Preferences window.  

  

5.3 Exercise: Importing Files, View Controls and More …  

  

Eventually, it is time that you explore the above yourself. In this lesson, you will learn about:  

• The ribbon  

• Importing files  

• View controls  

• Showing and hiding parts  

• Creating and editing forces  

• Creating and editing draw directions  
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Dual bracket  

 

 

 

 

 

 

            

 

 

 

Model file: Click Here  

 

 

Step 1: Explore the Ribbon  

1. Start Inspire.  

2. The ribbon across the top of the application displays all the tools available in Inspire. Click on the tabs at the top of 

the ribbon to switch between the File, Edit, and View menus and the Geometry and Structure ribbons.  

 

3. Each icon on the ribbon provides access to one or more tools. As you move the mouse over an icon, the individual 

tools glow with a yellow border.  

4. Click the  icon next to the ribbon tabs to create a custom ribbon.  

5. Click the Custom tab to view the custom ribbon. The Home icon group is automatically included.  

 

6. Drag and drop tool icons on the ribbon to the Custom tab. You can also drag and drop to rearrange the order of the 

icons along the custom ribbon.  
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7. Right-click an icon label or a custom ribbon tab to rename or delete it. 

 

 

Step 2: Open the Dual Bracket Model  

You can create, open, and save models using the tools on the Files icon.  

1. Click Open Model on the Files icon.  

  

2. In the Open File select the dual bracket .stmod file  

3. Click Open. If not already visible, press F2 to open the Model Browser.   
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4. Click on the Unit System Selector in the lower right corner of the modeling window and set the default unit system to 

SI (m kg N Pa).  

 

 

  

 

Step 3: Use the View Controls  

1. Rotate the model by holding down the right mouse button while dragging the mouse. This rotation method is called 

turntable rotation and is useful if your model’s vertical direction is aligned with the z-axis.  

 

                                        

https://altair-2.wistia.com/medias/eeek6f8mv6  

 

2. Now hold down the middle mouse button while dragging the mouse. This is called trackball rotation and is useful for 

tumbling your model in any direction. Press the N key to rotate the model to the closest principal axes.  
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       https://altair-2.wistia.com/medias/mu30203byz  

 

3. Use the scroll wheel to zoom centered on the mouse cursor. To zoom around the center of the modeling window, 

press the Alt key and drag the middle mouse button vertically.  

 

 

 

https://altair-2.wistia.com/medias/id5gy4u468  

  

4. The view controls are in the lower left corner of the modeling window. Click the  icon in the lower left corner of 

the modeling window or press the F key to fit the entire model in the view. If parts are selected rather than the entire 

model, clicking this icon will zoom in on the selected parts. Clicking the icon again will zoom out to show the entire 

model. Try pressing F repeatedly with different parts selected to see the effect.  
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https://altair-2.wistia.com/medias/vzzh6p549h  

  

5. Pan the model by holding both the Shift key and the right mouse button while moving the mouse. Press the C key 

and click a point on the model to center it around that point.  

 

 

https://altair-2.wistia.com/medias/tcid1clmqr  

6. To customize your mouse controls to mimic a different application, select File > Preferences to open the 

Preferences window. Then select Mouse Controls and choose an application from the drop-down list.  
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Step 4: Show and Hide Parts  

You can show and hide parts using the Show/Hide icon in the view controls.  

1. Click the Show/Hide  icon in the lower left corner of the modeling window.  

2. Hover over a part. The mouse cursor will change to , indicating that you are in show/hide mode.  

3. Left click one or more parts in the modeling window. The parts turn transparent as you select them and are greyed 

out in the Model Browser.  

 

 

       

  

4. Right-click to exit the show/hide mode. The selected objects are hidden in the modeling window.  

5. To show pars that are hidden, select the Show/Hide  tool again to enter show/ hide mode.  

6. Click on a transparent part while holding down the Shift key. Note that while the  
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7. Shift key is pressed, the cursor changes to .  

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

8. Click on the remaining transparent parts, then right-click to exit show/hide mode.  

To show parts that are hidden, select the Show/Hide  
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9. Using keyboard shortcuts is another way you can show, hide, or isolate parts.  

a. Press the A key to show all parts.  

b. Press the H key to hide selected parts.  

c. Press the I key to isolate selected parts.  

d. Press the R key to reverse the selection (hide all selected parts and show all hidden parts).  

  

Step 5: Apply a Force and Draw Direction  

1. Select one of the brackets and press the I key to isolate it.  

 

 

 

2. Select the Structure tab on the ribbon.  

3. Click the Apply Force tool on the Loads icon.  
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4. Move the mouse cursor over the front face of the bracket and left click to apply a distributed force.  

 

                         

 

5. A micro dialog appears when creating or editing forces. Enter 45 N in the text field and click the +/- button to change 

the direction of the force.  

 

  

 

6. Now, apply a draw direction constraint to the bracket by left-clicking the Draw Direction tool on the Shape Controls 

icon (you’ll learn more about draw directions in later tutorials).  
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7. Click the Single Draw tool on the secondary ribbon.  

 

                 

   

8. Left click the bracket. A blue plane appears with four corner arrows pointing toward the front of the bracket, indicating 

the draw direction (the direction the mould will be pulled away from the part).  

 

 

 

9. Right-click on empty space or press Esc to exit the tool.  

  

Step 6: Edit the Force and Draw Direction  

Once objects have been created, it is easy to create more objects of the same type or edit those objects by double-clicking on 

them in the modeling window.  

1. Double-click the blue plane to edit the draw direction. You are now in edit mode, and a micro dialog appears.  
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2. Click one of the gray planes to activate it and change the orientation of the draw direction.  

 

 

 

3. Right-click on empty space or press Esc to exit the tool.  
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4. Double-click the red force arrow on the front face. You are now in edit mode, and a micro dialog reappears.  

 

 

  

5. You can edit the force by entering a magnitude in the text field or change its direction by pressing the +/-, X, Y, Z and 

 buttons.  

To quickly edit an integer value in a micro dialog, highlight any digits in the number and use the scroll wheel on 

the mouse.  

6. You can also create more forces by selecting another face, as shown below:  

http://altair.com/
https://www.altair.com/contact-us/


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       52 

  

  

 

  

7. Right-click on empty space or press Esc to exit the tool. 

 

 

  

5.4  File Management  

Creating a new model  

• Creating a new file clears the current model from memory and opens a new model file.  

  

Note the highlighted white “paper” indicating that a new model will be created  

  

Opening a model  

• Opening a model file clears the current file from memory and restores a previous model. Note that opening a 
model is different from importing geometry, which merges the contents of another file into the current model.  

  

Note: the highlighted folder indicates that an existing model will be opened  

(Inspire supports a variety of file formats, including ACIS, CATIA, IGES, JT, Parasolid, Pro/ Engineer, SolidWorks, STEP, STL, 

and Unigraphics files)  
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Saving a model  

• Save your current model file regularly so you don’t lose your work. Note that saving a model is different from 

exporting results.  

  

Note: the highlighted disc indicates that the model will be saved  

Saving a model overwrites the previously saved version of the file. Use the “Save As” command to save the current version to 

a different file.   

  

Importing geometry  

• Importing a file merges the contents of that file into the current model. This is different from opening a file, which 

clears the current file from memory.  

To import geometry, use File > Open  

To import and merge geometry into the current model, use File > Import  

  

Capturing an image  

• This option may be handy if you need to document your working steps within Inspire  

A screen capture saves an image of your model with a white background. These snapshot images are saved as .png files. To 

capture a snapshot of your model: Click on the File > Screen Capture from the ribbon menus  

In the Snapshots window, browse to the location where you want to save the image  

  

5.5 Selection and Editing  

In short - you can single-click an object to select it, and double-click to edit it using a micro dialog, graphic manipulator, or 

context menu.  

Selecting objects  

You can select objects in the following ways:  

• Left click to select a single object   

• Hold the Ctrl key to add or remove objects to or from a selection  

• Use window or “box” selection to select multiple objects simultaneously  

• Dragging left-to-right selects every object the box touches   
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• Dragging right-to-left only selects objects entirely within the box  

 

 

Editing objects  

In most cases, you can click double-click or right-click an object to edit it using a micro dialog, graphic manipulator, or context 

menu.  

Micro dialogs: Double-clicking an object selects the object and either activates an appropriate editing mode or opens a micro 

dialog with editing options  

Graphic Manipulators: Once in an editing mode, some tools feature graphical handles that can be manipulated using a mouse, 

such as the Move tool and Push/Pull tool  

Context Menus: Right clicking an object in the Model Browser or modeling views opens a dynamic context menu. The options 

in the context menu change based on the type of object selected Property Editor: Specific properties of an object, such as its 

name, color, and visibility, can be viewed and modified by selecting the object and pressing F3 to open the Property Editor. 

This is generally the least convenient method for editing entities, but is the only way to access some advanced functions  

 

Copying objects  

• The Cut, Copy, and Paste functions in Inspire follow standard software conventions.  

 

  

Deleting objects  

• Select the object(s) and press the Delete key  

• Right-click an object and select Delete from the context menu  

• To restore a recently deleted object, press Ctrl+Z on the keyboard, or choose Edit  

> Undo from the pull-down menu  
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Renaming objects  

• Typically, the following characters should be avoided: “ ‘ * ? $.  

 

5.6 Organizing Your Model  

 

Model Browser  

The Model Browser shows all the objects in your model in a tree structure. It is useful for organizing your model and for 

accessing objects that aren’t currently shown in the modeling window.   

Press the F2 to open the Model Browser or use the View menu.  

 

 

You can use the “Model Browser” to:  

• Find and search for objects in your model.  

• Show and hide objects in your model  

• Organize parts into assemblies and alternatives  

• Organize loads, supports, and displacement constraints into load cases  

• Configure your model by activating and deactivating parts and assemblies.  
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Show and Hide 

Each object in the Model Browser is preceded by an icon that indicates the type of object. Clicking on an object’s icon shows 

or hides the object in the modeling window with each successive click. When an object is hidden, it appears greyed out in the 

tree structure.  

 

 

  

 

 

 

You can also show and hide objects using the Show/Hide tool in the view controls  

Note: Objects that are hidden don’t appear in the modeling window but are still included in all calculations such as 

optimization, static weight calculations, mass computations, etc. To exclude an object from these calculations, you must 

deactivate it using the Configure toolbar on the Model Browser. This is called configuring your model.  

 

Search, Find, Filter  

You can find and search for objects such as parts, assemblies, loads, and shape controls in the   

Model Browser by clicking the Find  or Search and Filter  icons in the browser’s title bar.  

 

 

 

 

5.7 Units and Measurements   

Units are of course important (use the unit system you feel most comfortable with).  

You can change the current unit system using the “Unit System Selector” located in the lower right corner of the workspace. 
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Most numbers in a model have units associated with them, such as centimeters or inches for length, and kilograms or slugs 

for mass. Units are always displayed to the right of numbers wherever they appear  

Very helpful: When you enter a number in a field, the appropriate unit is automatically appended. If you type a unit after a 

number, the number is converted to the current units. For example, entering 10 in. inside a field where millimeters are the 

current units results in 254 mm. being displayed.  

 

5.8 Appearance Properties 

Assigning different colors to the parts and assemblies in your model is a good way to help organize it visually. You can assign 

colors to all non–design spaces automatically using the “Auto Color” command in the “View” menu, or you can assign specific 

colors manually using the “Color Selector”  

Following is a list of general properties and the types of objects to which they apply (indicated in parentheses). Press F3 to 

open the Property Editor  

  

Visible (all) - Indicates whether the selected object is visible in the modeling window. Color (all) - Indicates the color assigned 

to the object when it is displayed in the modeling window  

Transparency (models, parts) - Allows you to change the transparency of the selected object, according to a percentage. By 

default, objects are 0% transparent  

Auto Color- You can assign colors to all non–design spaces automatically using the  

Auto Color command. Just select the View > Auto Color command 
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6.  Geometry Building and Editing  
 

Most of the exercises contained in this book come along with a given geometry. However, later you may need to construct 

geometry yourself. Hereto, you may use Inspire (see exercises and explanations below), any CAD system or Altair Evolve. 

Evolve, which is part of your installation, is powerful and offers many more functions compared with Inspire (see also the 

Appendix “CAD Sketching (first ideas) with Evolve”).   

Overall, we think it is beneficial for your work if you are familiar with some of the geometry creation and editing functions 

available in Inspire.  

  

 Watch - Sketching Geometry  

 

             

https://altair-2.wistia.com/medias/rsoyntaynm  

  

  

  

6.1 Exercise: Sketching Geometry 

 

In this exercise, we are going to sketch the geometry of a “bridge” (very bulky geometry).  

Create a new model  
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Define the unit system to be used, here it will be CGS (cm g dyn s). Of course, you can use a unit system you may feel more 

comfortable with. In that case make sure your units are consistent.  

 

  

  

A sketch plane appears.  

 

  

Zoom out using the “scroll wheel” on the mouse  

  

  

Activate the “Geometry Ribbon”   

  

Select “Rectangle by Corners”   
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Draw a rectangle by clicking the “left mouse button” once to place the first corner, and a second time to place the opposite 

corner, so that the dimensions of the rectangle are 30 cm by 10 cm.  

 

                         

  

Then right-click or press Esc to exit the tool.  

  

http://altair.com/
https://www.altair.com/contact-us/


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       61 

  

  

                      

  

 Right-click or press Esc again to exit sketch mode and enter push/pull mode.  

 

                      

  

Use the right mouse button to rotate the model forward slightly, then click and drag with the left mouse button to pull the 

rectangle into a solid 10 cm thick. Then right click or press Esc to exit push/pull mode  
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Click and drag with the right mouse button to orient your model so that the z-axis is in the vertical direction, as shown below: 

 

                  

 

Some part of the interior will be “removed” next.  

Select the “Rectangle by 3 Pts” tool on the Geometry ribbon   
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Click on the square end of the solid to select the sketch plane.  

 

                        

  

Use the right mouse button to rotate and adjust the view as shown  
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Draw a rectangle by clicking the left mouse button twice to place the bottom two corners, and a third time to place the center 

of the opposite side. The rectangle should be 6 cm tall and 8 cm wide and positioned along the bottom edge of the solid  

  

                  

  

  

Then right-click or press Esc to exit the tool. Right-click or press Esc again to exit sketch mode and enter push/pull mode  

  

                     

  

Click and push on the surface with the left mouse button to push a hole through the solid.  
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Right-click or press Esc to exit push/pull mode and use the right mouse button to orbit the model.  

 

                 

 

Some of the interior was carved away. In the next step, we are “shaping” the left/right side.  

Click the Rotate to Closest Principal Axes  icon at the bottom left corner of the modeling window, then use the scroll 

wheel to zoom out and the mouse controls to adjust the view as shown  
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Select the Lines tool on the Geometry ribbon  

  

 

Click on the solid to select the sketch plane  
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Draw a line by clicking the left mouse button twice to place the end points, one at the bottom corner and another 5 cm along 

the top edge, as shown below (the length of the line will be about 11.18 cm).  

 

                   

 

Draw a second line on the opposite side of the rectangle, indented 5 cm along the top edge, as shown below  

 

                    

  

Right-click or press Esc to exit the tool, and right-click or press Esc again to exit sketch mode and enter push/pull mode  
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Click and push one of the triangular surfaces with the left mouse button to trim the solid.  
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Click and push the other surface with the left mouse button to trim the opposite side.  

  

                    

  

Right-click or press Esc to exit push/pull mode, and use the right mouse button to orbit the model  

Next, we are going to create a rectangular base for the bridge  

Using the right mouse button, rotate the model so you can see the bottom of the bridge, as shown below  
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Select the Rectangle by Corners tool on the Geometry ribbon  

  

 

Click on one of the bottom faces to select the sketch plane  

  

and the geometry you are about to create will be placed in that new part.  

Click the Create New Part     button. A new part appears in the Model   
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Using the left mouse button, draw a 30 cm by 10 cm rectangle on the bottom face by placing two opposite corners, as shown 

below:  

 

  

Right-click or press Esc to exit the tool.  
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Right-click or press Esc again to exit sketch mode and enter push/pull mode  

  

 

  

Click and drag with the left mouse button to pull the rectangle into a solid 1 cm high (alternatively, you can enter 1.0 in the text 

field and press Enter).  
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Right-click or press Esc to exit push/pull mode, and use the right mouse button to orbit the model  

 

 

 

Done. Congrats.  

  

  

 

 

http://altair.com/
https://www.altair.com/contact-us/


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       74 

  

  

6.2 Sketch Constraints  

When sketching, you can apply geometric relationships such as tangency, perpendicularity, etc. to lines, rectangles, circles, 

and arcs using sketch constraints. As you sketch, Inspire automatically applies many sketch constraints for you.  For instance, 

if you draw a line that is nearly horizontal, a horizontal constraint will be created on that line automatically, making it precisely 

horizontal for you.  When you modify a sketch, the constraints ensure that the intended relationships between the sketch 

entities remain intact.   

You can apply sketch constraints by right-clicking on a curve when in sketch mode and selecting a constraint from the context 

menu. You can also create some constraints by right clicking on the connecting point between curves.  

 

https://altair-2.wistia.com/medias/arv0s0hpy0  

  

The following sketch constraints may be applied, although some are only applicable to certain types of curves. If a constraint 

cannot be applied to the selected geometry, it appears greyed out in the context menu. In some cases, the application of 

certain constraints may cause the geometry to be overly constrained, in which case you will receive an error message  

  

Fixed  

Use to constrain a sketch point, line, or curve so that it maintains a fixed position relative to adjacent sketch curves (the object 

itself is not fixed in 3D space. You can still move it by clicking-and-dragging). Points, lines, circles, and arcs can all be fixed.  

The edges of rectangles are separate entities and can be fixed independently.  
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https://altair-2.wistia.com/medias/rmweg2dfai  

  

 

Horizontal  

Use to position lines segments horizontally with respect to the sketch plane. Right click the line segment to open the context 

menu  

 

Then select the Horizontal icon.  
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Vertical  

Same process - Use to position line segments vertically with respect to the sketch plane.  

Right-click the line segment to open the context menu  

 

Then select the Vertical icon.  

  

Collinear  

Use this functionality to align two or more-line segments Hold down the Ctrl key to select multiple line segments.  

 

Activate the collinear icon results in:  
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Parallel  

Use to position two lines segments so they are parallel. Hold down the Ctrl key to select multiple line segments.  

Right-click one of the selected line segments to open the context menu  

 

With the Parallel icon activated:  

 

  

Perpendicular  

 

  

  

  

Similar process as before … 
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Tangent  

Use to position a line segment so that it is tangent to an arc.  

 

https://altair-2.wistia.com/medias/5autnrslq8  

  

  

Concentric  

Use to align two or more circles so they are concentric. The process - without many words ….  
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6.3 Exercise: Simplifying Geometry   

Simplifying geometry is quite an important topic.   

Why?   

You may recall from the introduction in the CAE Driven Design Process, that the concept optimization typically starts with a 

rather “bulky” kind of geometry (to give the optimizer more freedom). Especially if the geometry is provided by someone else - 

just recall the story from Volkswagen about the bracket - you may face the challenge to simplify the given geometry by 

removing fillets, ribs and holes.  

Hence, the next exercise covers the following topics:  

• Find and remove pockets and holes  

• Find and remove rounds and fillets  

• Push and pull faces Model file:    

Click Here  

 

Let’s get started. Click Open Model on the Files icon  

  

 

• Select the Geometry_Simplification.x_t file and click Open. Adjust the view so the model is positioned as shown 

below  
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Be sure the Unit System Selector in the lower right corner of the application is set to MPA (mm t N s).  

 

  

  

Remove Holes and Pockets  

• Select the Simplify tool on the Geometry ribbon.  

 

• Select the Holes tool from the secondary ribbon.  

  

 

Inspire automatically finds all the holes and pockets in your model, which are shown in red. The number shown above the 

Holes icon indicates the total number of holes and pockets found, in this case twelve.  
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• Move the mouse over one of the pockets. You’ll notice the mouse cursor changes and shows a check mark, then 

left click the pocket to remove it.  

 

Note the difference in the geometry, i.e. the pocket on the left side is removed  

• Continue removing the other five pockets (there are three on each side) by left clicking on them. Do not remove 

the holes. When finished, right-click to exit the tool.  
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Find Rounds and Fillets  

• Click the Remove button   to remove all fillets and rounds. You’ll notice not all fillets have been 

removed  

 

  

• Zoom in on the single fillet that appears in the top left corner of the model. Mouse over the fillet and left-click to 

select it.  
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• Left click the fillet again to remove it.  

  

 

  

• Zoom out, rotate the model, and hover your mouse over the round shown in the picture.  
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• Double left-click this round. You’ll notice the entire chain is selected.  

  

 

  

• Left click again to remove the chain.  
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• Rotate the model and remove the round chain on the other side of the model. You can select, deselect, and 

remove individual rounds or chains of rounds in the following ways:  

• Click on a round or fillet to select it  

• If there are several contiguous rounds or fillets, double-click one to select the entire chain. Selecting an adjacent 

round/fillet will add to the chain.  

• Click on a selected round or fillet again to remove it. If it is part of a chain, the entire chain will be removed.  

• Hold down the Ctrl key and left click to deselect a round or fillet. Hold down the Ctrl key and double-click to 

deselect an entire chain.  

 

 

• Now the rounds and fillets are completely removed. When finished, right-click to exit the tool.  
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Push/Pull Interior Faces  

With the rounds and fillets removed, it is possible to push and pull the interior faces.   

• Select the Push/Pull tool on the Geometry ribbon  

• Left click once on the face shown below  
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• Click and drag the pyramid to position it on the exterior face. This will redefine the starting point of the push/pull 

operation  

 

  

  

• Type 12 in the microdialog and press Enter  

  

 

  

• Repeat the push/pull procedure for the other interior face, pulling it to 12 mm.  

When finished, right-click to exit the tool.  
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Watch – Mirror Model  

 

 

https://altair-2.wistia.com/medias/hxw20ubvsi   
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Watch - Scale   

 

 

https://altair-2.wistia.com/medias/if8p7rz855  
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7.  Analysis – How to Do It?  
  

Do you recall the overall workflow of a Finite Element Analysis (described earlier)?   

Knowing the overall workflow helps you mastering your simulation tasks. Naturally, the workflow will become clearer after you 

have completed a few of the exercises below.  

The workflow:   

Geometry - loads and constraints - materials & properties (e.g. sheet thickness) - analysis run settings - analysis run - 

postprocessing   

The video below may be of interest - also because you worked in the geometry before.   

  

Watch - Analysis Setup  

 

 

https://altair-2.wistia.com/medias/dn3ie1d2as  
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7.1 Exercise: A Step by Step Tutorial on How to Perform A Finite 

Element Analysis   

(By Rahul Ponginan)  

Model file: y-bracket.stmod.zip  

  

Step 1: Open the Y-bracket Model  

• Start Inspire.   

• Click Open Model on the Files icon.   

 

• In the Open File window select the y-bracket.stmod file and click Open.   

• Click on the Unit System Selector in the lower right corner of the modeling window, default unit system to SI (m 

kg N Pa).    

 

• Use the right mouse button to adjust the view so the y-bracket is positioned as shown below:  

  

   

Step 2: Create a Center Hole Support and the First Load Case  

• Click the Structure tab on the ribbon.   

• Select the Apply Supports tool on the Loads icon.  
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• Click on the front boss material to apply the support. Here all 6 DOF’s are constraint.  

(DOF refers to Degree of Freedom. Typically, we have to make up our mind about the 3 translational displacements (x-y-z- 

direction) and 3 rotational displacements (rotation with respect to x-y- or z-axis). If all DOF’s of the node are set to zero “0”, the 

node remains absolutely fixed in space. If DOF 1,2, and 3 are set to zero, then we may still see rotation and so on).  

  

 

 

• In the Model Browser, two new folders are created, one called Load Case 1 and the other called All Loads and 

Displacements. Support 1 is added to both.   

 

• Click on Load Case 1 twice, rename it “Load Case X,” and press Enter. The name of the load case is shown in 

bold, indicating that it is the current load case. Any new loads or supports that you create will be added to it 

automatically.   
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Step 3: Apply Forces to Boss Materials   

• Select the Apply Force tool on the Loads icon on the Structure ribbon.   

 

 

 

 

 

 

 

• Click on one of the rear boss materials to apply the force.  
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• The force is initially applied in the negative x direction. Click the +/- icon in the micro dialog to reverse it to the 
positive x direction.    

 

 

     

• Force 1 appears in the Model Browser in both the All Loads and Displacements folder and Load Case X.   

 

• While the Apply Force tool is still active, click on the other rear boss material and use the +/- icon to reverse the 

direction. Both Force 1 and Force 2 should now be applied in the positive x direction, as shown in the image 

below:   
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• Force 2 appears in the Model Browser in both the All Loads and Displacements folder and Load Case X.   

 

• Right-click or press Esc to exit the tool.     

  

Step 4: Define Material  

• You can right click on the model and choose the material or create your own material using the Materials Tab, 

the material definition is important as we intuitively understand that steel is stronger than plastic and hence is 

critical for the analysis.   
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Step 5: Run a Baseline Static Analysis  

• Select the Structure tab on the ribbon.  

• Click Run Analysis         on the Analyze icon to open the Run Analysis window. 

              

 

 

 

 

 

 

 

 

 

 

 

 

 

• Change the Element size to 3 mm  

 

  

• Make sure that Speed/Accuracy is set to More accurate.  

 

   

• Click Load Cases and verify that Load Case X is selected.   

• Click Run to perform the analysis. The Run Status window appears. A green check mark will appear when the 

analysis is complete (this may take several minutes).   
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• Double-click on the name of the run to view the results. The results are displayed in the Analysis Explorer.   

 

  

  

Step 6: View the Results  

Most of the time you are looking at so called contour plots., i.e. results such as displacements or stresses are displayed using 

colors (either single color ranging from bright to dark or rainbow colors).   

Note: a colored analysis results do not guarantee that everything with your model is correct.  

To change the Analysis Legend Colors from single or divergent color to Rainbow select  

File > Preferences > Run Options as shown below   
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Displacements shown with single color option  

• In the Analysis Explorer under Result Type, select Displacement.   

 

   

• The maximum displacement for the model is approximately 2.6e-4 mm, as shown in the legend.  
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The same results are now shown using rainbow colors. At the end it will be up to you to use the one or the other coloring 

method. 

 

 

Note: As it is a symmetrical model with symmetrical loads applied, the contours (here displacements) are also expected to be 

symmetrical  

Always very helpful is to animate the results as it helps to better understand the overall behavior of the model. In this way you 

may see that the model was not properly constraint (fixed).  

For your information - the program interpolates the results between the initial (zero displacements) and the final state.   

• Click the Show/hide deformed state  icon to show the deformed state of the model. Click the icon again to 

hide it.   

• Click the  button under Animation to visualize the displacement.   

• Click the   button and use the slider to change the speed of the animation.   

• Inspire automatically scales the displacement animation to make it easier to see.  

• Click the  button, deselect Auto, and enter a value to change the scale of the animation.   

• Click the  button to stop the animation.   

 

Step 7: View the von Mises Stress Results  

In the image below the von Mises Stress is shown. The von Mises failure criterion is typically used to assess the structural 

performance of ductile materials. A material is said to start yielding –which in many instances is considered failure –when the 

von Mises stress reaches the yield stress (for an explanation about von Mises Stresses please refer to the Appendix “How To 

Interpret Finite Element Analysis Results”). In general, red colors indicate “high” or critical values, whereas blue colors (cold) 

refer to “safe” areas.    
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7.2 Exercise: Plate with A Hole  

(Prepared by Sanjay Nainani)  

Even though Inspire takes care of meshing, i.e. chooses the element configuration and appropriate element size, it is 

important that you understand that the mesh properties intrinsically influence the simulation results.  

We therefore included this “standard” exercise: A plate with hole. The plate, subjected to forces applied at an edge, will be 

meshed using different element sizes.  

The simulation results will be compared with each other.  

  

Stress Calculation: Analytical Approach  

To properly interpret the FEM analysis results error, one should calculate the theoretical values for stresses that will occur 

near the notch. For that, simple stress concentration calculator was used, which is available on amesweb.info website.   

The model of the plate that will be used has following dimensions:  
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Dimensions of the plate  

 

The tension load that will be applied to one of the plate’s edges is equal:  

F = 20 000 N 

The other edge will be constrained with respect to all 6 DOFs (do you recall the definition of DOF? What does DOF 1 stands 

for? (see the comment about DOF in the previous exercise) The results that were acquired from the calculator are:  

 

Parameter  Symbol  Value  

Stress concentration factor  Kt  2.3 

Nominal tension stress  σnom  83.33 MPa 

Maximum tension stress at the edge of the hole  σmax  192.02 MPa 

  

The equation describing the relation between these values is as follows:   

𝐾𝐾𝑡𝑡 = 𝜎𝜎𝑛𝑛𝑛𝑛𝑛𝑛⁄𝜎𝜎𝑛𝑛𝑚𝑚𝑚𝑚  

The following exercise serves two needs/objectives:  

• To highlight/demonstrate the general workflow of a Finite Element Analysis   

• Make students aware that simulation results need to be considered with care  
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FEM Analyses of The Plate  

Different element sizes will be used to investigate the accuracy of the results as a function of element size. The chosen 

element sizes are:  

 

 

  

 

 

 

 

 

 

 

 

 

 

The model will be set up using quad elements. The force will be applied to the nodes distributed over the right edge of the 

plate. The boundary condition will be set to the nodes of the left edge of the plate. The next image depicts the FEM model of 

the plate.  

 

 

FEM model with forces and constraints applied  

  

Recall: You can define the (global) element size in the analysis panel by simply typing in the desired size (in the panel 

highlighted in green).  

 

  

Alternatively, you can define the local element size (which prevails the global definition) per part/component in the Property 

Browser. By default, the mesh size is determined automatically (referring to the analysis panel):  

 

N°  Element size  

1  20 mm  

2  10 mm  

3  4 mm  

4  3 mm  

5  1 mm  
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If you de-activate the check-box next to “Autocal …” you can insert the desired element size for this particular part/component  

 

 

 

The element distribution (mesh) near the hole is presented in the following figures:  
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Element size 20 mm          Element size 10 mm 

 

 

Element size 4 mm            Element size 3 mm 

 

  

 

 

 

 

 

        

        Element size 1 mm  
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Results & Conclusions  

On the figures below stress contours are presented for each case. Logically, maximum resultant stress gets closer to the 

theoretical value with increase of element density.  

For Faster  

“Faster” is typically selected when testing your model to ensure that loads and supports are correct. Once you are comfortable 

with the results, select “More accurate” and rerun the analysis to achieve more precise stress and displacement results.  

 

 

Von Mises stress contours around the hole with 20 mm elements  

 

 

Von Mises stress contours around the hole with 10 mm elements  
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Von Mises stress contours around the hole with 4 mm elements 

 

Von Mises stress contours around the hole with 3 mm elements 

  

 

Von Mises stress contours around the hole with 1 mm elements 
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Element Size  
Maximum von Mises 

Stress  
Theoretical Value  Relative Error  

20 

mm 

90.95 

MPa 192.02 MPa 

 

%  

10  116.4  

4  152.1  

3  159.2  

1  186.3  

 

Von Mises stress for different element sizes (run setting: Faster) 

  

 

For Accurate:  

Recall - “Faster” is typically selected when testing your model to ensure that loads and supports are correct. Once you are 

comfortable with the results, select “More accurate” and rerun the analysis to achieve more precise stress and displacement 

results.  

  

52.63   

39.38   

20.78   

17.09   

2.97   
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Exemplarily, we show the results of the 3 mm mesh next  

 

 

Von Mises stress contours around the hole with 3 mm elements (run setting: Accurate)  

  

  

Element Size  Maximum von Mises Stress  Theoretical Value  Relative Error  

20  

mm  

96.12  

MPa  192.02   MPa  

49.94  

%  

10  123.2  35.84  

4  152.1  20.78  

3  159.4  16.98  

1  187.3  2.46  

Von Mises stress for different element sizes (run setting: Accurate)  

  

Note that both element size and the setting Faster/Accurate affects the results (as expected). Keep this and the 

recommendations made in this chapter in mind while working on your own projects!  

Note: If you run several different combinations (e.g. 20mm, 10mm, 3 mm and so on), make sure and save the model 

afterwards (.stmod file).   

At some time (later) you most likely want to check the run settings. This can be accomplished by activating the Restore button 

within Run Analysis panel.  

This then will list all runs contained in the stmod file   
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After you have selected the run of interest, the settings shown in the Run Analysis panel will be updated.   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

 

 

7.3 Exercise: Wrench  

(By Sanjay Nainani)  

  

The working process practiced in the previous exercises are repeated with respect to the wrench shown below. As you should 

feel somewhat familiar with the process, we kept certain explanations rather short.  

 

Model file: Click Here  
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First steps:  

• Change the unit system to MPA ‘mm t N s’  

• Open the file wrench.stmod   

• Go to View and turn on Model browser (F2) and Property Editor (F3). Now, change the model view from iso 

(isometric) to top by placing the cursor on the global system and selecting Top as shown below   

 

 

Assigning Material and Properties   

• Select the model in the graphics area by using left click of the mouse   

• In the Property editor specify the thickness as 3mm   

 

 

• Go to Structure tab, and select Materials > My Materials and click + to add the material   

• Rename the material as Steel and edit the following properties   
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• Young’s Modulus: 200E+03 MPa   

• Poisson’s ratio: 0.3   

• Density: 7.85E-09 t/mm3    

• Yield Stress: 285.000E+00 MPa. 

 

 

  

• Now go to Parts tab and assign the newly created Steel material as shown below by scrolling to the bottom of 

the pull-down menu   
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Assigning Boundary and Loading Conditions   

 In the Structure tab, go to the Loads ribbon and select Apply Force   

• Select the Wrench edge as shown and give the force value as 880 N in Y-direction. If the force arrow is facing 

upwards, left click on +/- icon to change its direction to the opposite way   

 

 

• Now select Apply Supports in the Loads ribbon and select all six edges of the hole as shown in the picture which 

are constrained in all degrees of freedom (DOF)   
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 Running the Analysis (Wrench_4mm_Faster)   

 

 

Wrench model meshed with element size 4 mm  

 

• Select Run Analysis in Analyse ribbon under Structure tab   

• Give the Name of run as Wrench_4mm_Faster and give the element size as 4 mm   

• Select Speed/Accuracy as Faster   

• Now click Run. Inspire will run the linear static analysis  

 

 

  

Viewing The Results (Faster, Wrench_4mm_Faster)  

• After the analysis is completed, close the status window and select Import Completed Runs (green flag) as 

shown   
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Now you can view the results of the Wrench_4mm_Faster run. Select the Factor of Safety as the result type. Select (Turn on) 

Show Initial Shape and Deformed Shape as shown below   

 

Factor Of Safety (Wrench_4mm_Faster)  

 

 

• By default, inspire will plot Factor of Safety of the model in a way that the material close to factor of safety 1 will 

be in red color and the higher safety factor area will be in blue color (i.e. safer)  

• Now view the results  for von-Mises stress and displacement for Wrench_4mm_Faster.    
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Von Mises Stress (Wrench_4mm_Faster)  

 

 

    

  

Displacement (Wrench_4mm_Faster)  

• Select Animation Play button to animate the model  

 

 

Running The Analysis (For Wrench_1mm_Faster)   

• Select Run Analysis in Analyse ribbon under Structure tab   

• Give the Name of run as Wrench_1mm_Faster and give the element size as 1 mm   
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• Select Speed/Accuracy as Faster   

• Run the analysis   

• Follow the above steps to view the results for this load case   

 

Wrench model with element size 1 mm  

  

  

 Viewing the Results  

 

Factor Of Safety (Wrench_1mm_Faster)   
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Von Mises Stress (Wrench_1mm_Faster)    

 

 

   

   

Displacement (Wrench_1mm_Faster)  

 

 

  

Running the Analysis (Wrench_1mm_Accurate)  

• Select Run Analysis in Analyse ribbon under Structure tab   

• Give the Name of run as Wrench_1mm_Accurate and give the element size as 1 mm   

• Select Speed/Accuracy as More Accurate and run the analysis  
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• Follow the above steps to view the results for this load case (viewing the results)   

  

Viewing the Results  

Factor of Safety (Wrench_1mm_Accurate)  

 

 

 

Von Mises Stress (Wrench_1mm_Accurate)  

 

 

 

 

 

http://altair.com/
https://www.altair.com/contact-us/


eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                       119 

  

  

Displacement (Wrench_1mm_Accurate)   

 

 

  

  

Comparing the Results   

• Select compare results to estimate different results of three runs   

 

 

 

• Right mouse clicks on the title bar as shown below to select result types factor of safety, displacement and von 

Mises stress    
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• Click on the arrow of the von Mises stress result type on the title bar as shown below to arrange in ascending or 

descending order.   

  

 

  

• Click on the Hide Elements as shown above to see element view of the model.   
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7.4 Exercise: Normal Mode Analysis of a Fender  

(Tutorial prepared by Rahul Rajan)  

 

 

Objective: 

Determine the first eigenfrequency of the given fender design. 

Project related model files: 

Click Here  

In the video below the overall workflow is described. It should help you to run this modal analysis yourself.  

 

https://altair-2.wistia.com/medias/a5wfbnvs9z  
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Material & Property Definition  

• To create material Structure ribbon>Setup toolbar>Materials   

• Create own material using My Material.  

 

• To assign thickness select the parts from the Parts & Material tab.  

 

  

Connectors & Boundary Conditions  

• To create connectors Structure ribbon>Connection toolbar>Connector  

• Select the circular edge of the hole & two adjacent edge of mount surfaces to create a connector.  

• To create constraints Structure ribbon> Setup toolbar >Loads   

• Restrict all translation DOF for two holes (recall the definition of DOF)  

• Restrict translation DOF along Y Axis for Fender center location.  
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Run Modal Analysis   

 

• Let the element size be default 3.96 mm  

• Expand the normal Modes and select 10  

• Select Load Case 1 for the use of supports from load case  

• Select Faster for Speed/Accuracy  

• Select Sliding Only for the Contacts  

• Click run   
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Modal Analysis Results  

 

 

 

 

 

 

 

 

 

 

 

 

 

First frequency 60 Hz 

  

Later we will run a topography optimization on the fender geometry in order to improve its vibrational characteristics (i.e. move 

the first eigenfrequency as high as possible).  

  

 

7.5 Cap Stone Project: Modal Analysis of a Steel Frame  

 

By now you should have a fair understanding on how to create and edit geometry, and how to run an analysis. Hence, it is 

time to challenge you a bit with this “exercise”:  

• create the geometry (as shown in the image below)  

• assign material properties, loads and constraints  

• run a modal analysis and compare your results (frequency and eigenmode i.e. the way the geometry 

swings/vibrates)   

This demanding tutorial was initially created for our advanced CAE software HyperMesh (model building) – OptiStruct 

(analysis) – HyperView (visualization of results). The author Sushanth Kumareshwar Panchaxrimath (Michigan Dearborn 

University, Mechanical Engineering) was so kind and shared his work with us (end 2016).  
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Read more about his study:  

http://www.altairuniversity.com/learning- 

library/modal-analysis-of-a-steel-frame/   

  

  

Summary   

• The geometry of the steel frame is constructed using the CAD sketcher tool that comes pre-built with the Inspire 
software (if you want to skip the “drawing” part of this exercise you can also download the geometry here ....)  

• A modal analysis of a steel frame (using free-free condition, i.e. no constraints, no loads/forces) is conducted 
with Altair Inspire.   

• Results obtained with Inspire are compared with the given experimental modal analysis results  

 

CAD Creation  

The given engineering drawing of the CAD geometry (steel frame) is as shown below:   

  

All units are in Inches 
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• Start Altair Inspire, select the geometry ribbon form the menu.   

 

• Rectangles option is selected and the 2D geometry of the steel frame is built as per the given engineering 

drawing.    

• After the 2D design is completed, the geometry is extruded for a given thickness (1 Inch). The final geometry of 

the steel frame is shown below.   
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Model Set-Up  

• Once the CAD geometry is created in the built-in sketcher of Inspire software, material has to be assigned to the 
model.   

• Click on structure menu and select --> material. A default material or a new material with the properties of the 
user’s choice can be created and assigned to the model.   

• In our case, we can define a new material named, ‘New Steel’ with the given properties.    

 

  

Analysis & Results   

• Click on the play button present in the Analyse menu.   

• Select the number of modes for the normal mode analysis.   

• Select the ‘more accurate’ option, to perform the second order meshing to obtain more accurate results and click 
on the run icon.   
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• Now the job gets submitted to the built-in solver.   

 

• Once the analysis is complete, a green flag appears on the analyze icon. Click the green flag to view the 

animation results for the various modes.   

 

  

Animation Results  
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Result Values  

The first mode in experimental analysis is the same as the 5th mode in Inspire.    

 

Analysis results from Inspire (modes v/s frequency)  

 

The Inspire analysis results are compared with the experimental analysis results (for the purpose of validation). This includes 

two sub sections, namely, comparison of the numerical results (value, data) and the comparison of the animation results 

(mode shapes comparison).  
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Comparison of numerical results  

  

Modal Mode Frequency (Hz) 
 

Inspire Mode 
Frequency (Hz) 

1   31.9734   5   31.1098   

2   43.7648   8   42.9046   

3   80.3804   12   80.8074   

4   94.9917   14   95.1742   

5   136.9682   18   136.6552   

  

    

 Comparison of Mode Shape Animation Results   

 

1. Modal Mode 1 v/s Inspire Mode 5    

 

 

Experimental (given) 
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Inspire Mode 5  

  

  

2. Modal Mode 2 v/s Inspire Mode 8  

 

 

      Experimental (given)  
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Inspire Mode 8 

  

  

3. Modal Mode 3 v/s Inspire Mode 12 

 

 

                

Experimental (given)  
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   Inspire Mode 12  

  

  

4. Modal Mode 4 v/s Inspire Mode 14 

 

 

 Experimental (given)  
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Inspire Mode 14  

  

  

5. Modal Mode 5 v/s Inspire Mode 18 

 

 

Experimental (given)  
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Inspire Mode 18 

  

  

  

 

 

  

  

  

  

  

 

 

Conclusion   

• The modal analysis of a steel frame was performed, and the results were compared.   

• From the analysis, it is observed that the results obtained from Inspire, match the given experimental results for 
the first three modes.   

• When the experimental results are compared to the CAE results, a mismatch occurs in the mode shape 

animation of the 4th and 5th mode. 

 

 

   

Modal Mode   Inspire Mode Shape   

1  Checked   

2  Checked   

3  Checked   

4  Slightly off   

5  Slightly off   
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7.6 Exercise: Buckling Modes Analysis of Steel Column  

(Tutorial prepared by Sanjay Nainani)  

 

 

Objective:   

Determine the buckling modes of the given steel column.  

Model File:  

https://altairuniversity.com/wp-content/uploads/2018/06/Buckling_baseline.zip    

    

Material & Property Definition  

• To assign material go to Structure ribbon>Setup toolbar>Materials   

• Assign Steel (AISI 304) to the Component  

 

• To assign thickness select the parts from the Parts & Material tab. Make sure the thickness is 3mm  

   

Boundary Conditions  

• To create constraints Structure ribbon> Setup toolbar >Loads   
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• Restrict all DOF’s for all edges on one side of the column (recall the definition of DOF)  

 

  

• Apply Load of 1000N each in -ve Z direction to all the four edges on the opposite side of the column.  
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Run Buckling Analysis   

 

 

• Let the element size be default 18.59 mm  

• Expand the Buckling Modes and select 10  

• Select Load Case 1 for the use of supports and loads from load case  

• Select Faster for Speed/Accuracy  

• Select Sliding Only for the Contacts  

• Click run   
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Buckling Analysis Results      

 

 

 

 

 

 

 

 

 

First Load Factor 69.6 

  

You can determine whether the part will buckle for a selected mode based on the value shown under Buckling Load Factor 

in the Analysis Explorer. This value can be multiplied by the load applied to determine the load value that will cause the part to 

buckle.  

 

 

 

 

 

 

 

 

 

 

 

 

The animation shows how the component will buckle.  

Now we will multiply the load applied by the Load factor and see if the component will buckle.  

As the first Load factor is 70, we will apply a load of 70000 N (70 * 1000N) on each of the four edges.  

  

 

 

 

 

1 < Load Factor The part will not buckle with the given value. 

0 < Load Factor ≤ -1 The part will buckle with the given value. 

-1 ≤ Load Factor < 0 The part will buckle if the load is reversed. 

Load Factor < -1 The part will not buckle if the load is reversed. 
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Select all the loads from the Model Browser and change the load to 70000N.  

 

 

Re-run the analysis with the same settings as earlier used.  
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Results  

 

 

First Load Factor 0.99 

  

Now, as the Load factor is less than 1, the component will buckle at the current load.  

  

A video about critical buckling load (from structurefree) can be found on Youtube: 

https://www.youtube.com/watch?v=yVfEmR-bkEI  
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8.  Concept Design with Inspire  
 

By now you should have a fair understanding of how-to set-up a model, how to run the analysis as well as postprocessing 

results. From the discussions above we know that “Analysis” is just a part of the “bigger” picture.  

We now will put our attention to the “Simulation Driven Design Process”. As you hopefully recall, it all starts with a conceptual 

design - coming either from a topology or topography optimization.  

  

8.1 Topology Optimization  

The topology optimization process carves material away from design spaces, creating the lightest structure capable of 

withstanding the forces you apply to your model. This approach is ideal for maximizing the stiffness of components while trying 

to achieve a desired mass target. It can also be used to minimize the mass of a model, depending on your optimization 

objective.  

View the following recording to get a better understanding (feeling) on how material efficient structures result out of a topology 

optimization:  

 

 

https://altair-2.wistia.com/medias/mw4s5hlnyf  

 

 

8.2 Topography Optimization  

Topography optimization is an advanced form of shape optimization that generates beads or swages on a design space. This 

approach is ideal for maximizing the stiffness of components without adding mass. It can also be used to maximize the 

frequency of a model, depending on your objective. Note that topography optimization only works on parts that are defined by 

surface geometry (thin walled structures). Maybe the above description is a bit too technical. We therefore show you the 

mechanical “impact” of beads by a very simple example.  
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Recall, beads are defined by its width, height and the draw angle.  

  

  

 

 

 

 

 

With this in mind we look at a simple sheet of paper which is fixed on one side. Due to gravity the paper bends downwards - 

nothing special as you have noticed this many time before.  

 

 

Next, we fold a bead into the sheet of paper and fix it again on one side. (Admittedly, this test is not perfect - but it helps to 

illustrate the concept; you also see that the applied “boundary condition” has a local effect)  

 

 

  

This time the sheet of paper doesn’t bend - the bead increased its stiffness without the need of adding more material (by 

thickening) or changing the material.   

The video below (an older recording) depicts how and where these beads form.  
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https://altair-2.wistia.com/medias/l02p9gywpa  

  

  

  

8.3 The Concept Design / Optimization Process  

 

Start with a design which is characterized by the maximum allowable dimensions of the final product (package space). At that 

point don’t think about where to put holes (to reduce its weight) or stiffening ribs. Of course, you can specify areas which need 

to stay the same, i.e. they will look the same after the concept optimization run. These areas are consequently called “non-

design” area (marked in gray color) whereas the rest may be modified (by the optimizing software)  

These portions of the structure are called “design area” (here in brown color)   

 

Design space: brown; Non-design space gray  
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Apply loads (i.e. forces, temperatures etc. acting on it) as well as material properties. In general, it is best not to apply 

loads and displacements directly to design spaces, as this often leads to incorrect results. Instead, you should split the 

part into design and non-design spaces and apply loads and displacements to the non-design spaces.  

 

 

Loads (forces) and constraints applied (here the constraints allow rotation around 

the respective axis, but prohibit translation) 

 

Define Manufacturing Constraints (Shape Controls). Without including manufacturing constraints, the optimized design may 

look great showing significant weight savings. However, the structure (new design) may not be manufacturable due to, for 

instance, undercuts. With respect to the brake pedal shown in this chapter the plan is to extrude the optimized design. This 

requires that the profile of the optimized design maintains a constant cross-section along the draw direction.  

Hence, traditional manufacturing processes (e.g. casting, stamping) require the definition of manufacturing constraints in the 

optimization set-up. The “situation” is different if the part will be manufactured by means of 3D (ALM) printing. In fact, topology 

optimization in combination with 3D printing brings the “power” of two disciplines together - an almost perfect symbiosis of 

technology. However, we know nothing is absolutely perfect - Thermal effects (deformation) while printing metal structures 

may become an issue...  

Use the Shape Controls to apply optional constraints to your model such as draw directions or symmetry. These tools can be 

accessed from the Structure ribbon.  

  

Note: Shape controls are applied to a design space and are not included in load cases. Once applied to a design space, they 

remain in effect regardless of which load cases are used during an optimization run.  

There are two basic types of shape controls available, and only one of each type can be applied to a design space (Inspire 

prevents you from applying multiple constraints that would create conflicting design goals).   

Draw directions are used to ensure that a design space can be physically manufactured using a specific process such as 

casting, stamping, or extrusion. These include the Single Draw, Split Draw, Stamping and Extrusion tools.   
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Note the highlighted area in the Shape Controls icon (draw directions is activated) and the upward pointing arrows.  

Only one draw direction can be applied to a design space. Draw directions are valid for optimization but not analysis.  

 

 

 

Single draw: The defined (or specified) draw direction is oriented normal to the blue plane. Note the single arrow symbol. You 

can activate any other plane by just clicking on it.    

In the next image the split draw option is shown. Note that the arrow symbol has changed - an arrow with two ends is shown.  

  

  

  

  

 

 

 

 

 

 

Next, extrusion constraints are applied. Again, note that the symbol shown at the edges of the blue plane has changed again. 

Extrusion direction is normal to blue plane.  
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Stamping can be applied from the part context menu. 

 

 

Again, note that the symbol depicted on the blue plane has changed.  

This type of constraint should be used when the manufacturing process calls for stamping rather than casting. When you run 

an optimization on a design space with a stamping constraint applied, the solver returns a result with uniform thickness while 

avoiding negative draft angles and internal voids.  

Symmetry and cyclic repetition are used to create optimized shapes with repeating patterns and/or nearly symmetric results. 

These include the Symmetric, Cyclic, and Cyclic Symmetric tools.  

 

   Shape Controls - Apply symmetric controls activated 
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Use the symmetry constraint to generate symmetric shapes, even under asymmetric conditions, by defining 

symmetry planes in the design space.  

  

 

Use the cyclic constraint to generate cyclically repeating shapes like starfish, propellers, or spoked wheels even if 

you use a design space or loads that are not cyclic themselves.  

  

Use the cyclic symmetric constraint to generate cyclically repeating shapes with symmetric sectors.  

  

  

 

Looking at thin walled structures (to be manufactured by stamping) the Bead Patterns option allow to control the overall shape 

(or pattern) of the resulting beads (not its height, width, angle -> this is defined in the optimization panel later).   

  

 

 

 

 

 

The following patterns can be defined:  

 Linear - Creates a linear bead pattern. One plane of symmetry is supported.  

   

 

 

Circular - Creates a circular bead pattern based on the bead width and height in the bead options. Two planes of 

symmetry are supported.  

  

Radial - Creates bead spokes in the radial direction. Two planes of symmetry are supported.  

 

 

Overall, we recommend testing different shape settings in order to better understand how these parameters affect the overall 

design.   
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Define the objective of the optimization run, e.g. what is the goal and purpose of the optimization. For instance, the objective 

may be to minimize the mass of the given initial (base) geometry (remove material wherever “possible”) or maximize the 

stiffness of the structure but use only a certain percentage of the initial volume/mass. Example: use only 30 % of the original 

volume/mass and “shape” it so that the structure will be a stiff as possible.    

  

 

             Max. stiffness with mass target                 Min. mass with stress (factor of safety) targets  

 

The simulation results (output of the optimization run) provides the concept shape of the product.  

 

 

Concept design  
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The concept shape (geometry) may needs to be smoothed (see the chapter about polyNURBS). In fact, the proper 

interpretation (smoothing) of the concept design has a tremendous impact on the final result (e.g. weight). If you are too 

“generous” in your interpretation you may add unused material to the design - and vice versa. At the end of the process 

the design needs (or should be) reevaluated to make sure that the product sustains the loads (forces, temperatures etc.).   

This process is described in some detail in the following recording (duration 27 minutes)  

 

 

https://altair-2.wistia.com/medias/zeuuqa6ecm  

 

 

8.4 Optimization Related Definitions  

In the previous chapter we used terms like design space or objective. Next, we summarize some of the most important terms.  

 

Design Space  

A design space is the initial geometry that forms the boundary of the optimized shape. It is typically a simplified representation 

of the existing part, with holes and pockets removed (compare with the video about topology optimization. Note the “bulky” 

geometry used at the beginning). Increasing the material available in the design space will yield a more optimized result.   

 

Objective:  

• Maximize stiffness - For topology optimization, the resulting shape will resist deflection, but may be heavier as 

a consequence (i.e. result in a shape that is the stiffest possible for a given mass).   

If you select maximize stiffness as your optimization objective, you will need to specify one or more of the following options in 

the Run Optimization window:  

1. Mass targets   

2. Frequency constraints and /or   
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3. Displacement constraints (applied using the Displacement Constraints tool).  

 

• Maximize frequency - For topography optimization, the resulting shape will create beads to increase frequency.  

When maximizing stiffness, you may choose to either maximize frequencies or set a specific minimum frequency. If you 

choose to maximize frequencies, inspire will automatically maximize both the stiffness and frequency of the model, and the 

lowest natural frequency will be displayed in the Shape Explorer window. If the resulting frequency is not high enough to meet 

your constraint, you may need to assign a stiffer material or modify your mass target for the optimized shape (if running 

topology optimization).  

When maximizing frequency as the optimization objective, you cannot set a minimum frequency, but you can choose whether 

to include supports from a specific load case.  

• Minimize mass - For topology optimization, the resulting shape will be lighter but may deflect more. By 
minimizing mass, you typically use stress or displacement constraints.  

Note: quite obviously, given a particular design space and the set of loads, supports, and shape controls applied to your 

model, you will see different results depending on which optimization objective you select.   

  

Constraints  

• Mass Targets - Mass targets are used to specify the amount of material to keep when running topology 

optimization and maximizing stiffness.  

• Bead Options - Bead options are used to help control the manufacturability of the design space when running 

topography optimization.  

• Stress Constraints - A stress constraint can be applied to limit the maximum stress in the model and is used 

when your optimization objective is to minimize mass.  

• Frequency Constraints - If you want to control the frequency at which an optimized part vibrates, you can set 

frequency constraints before maximizing stiffness or minimizing mass.   

• Thickness Constraints - When running a topology optimization, you can control wall thicknesses and the 

diameters of beam-like members using thickness constraints.  

• Displacement Constraints - Displacement constraints can be applied to a model  to limit deflections in desired 

locations and directions. 
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8.5 Exercise: Re-Design of A Towing Hook  

(Revised and updated to the new version and material added by Sanjay Nainani)   

 

 

Objective: 

Maximize the stiffness of the towing hook, however, use only 30% of its original volume/mass.    

• Open the file support_plate.x_t    

• Press F2 to open the Model Browser. 

• Press F3 to open the Property Editor.    

• Set the Unit System to MPA (mm t N MPa).    

 Edit the given geometry (to define the non-design space)  

• Select the Circle by centre and point tool on the toolbar    

• Select the outer face of the support plate. A sketch plane will appear.    
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Click the floating Create New Part icon to place what you are about to sketch into a new part.    

• Click on the centre of the projected circle and then click in any place of its perimeter to make a copy of the 

original geometry.    

 

    

• Using the same centre, create a second circle with diameter of 30 mm.    

 

• Click on the Push/Pull Faces icon in the main toolbar.    
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• Click on the external circle and when the floating dialog box opens type -10 mm and press enter to extrude the 

circle.    

   

 

   

• Now select the inner circle and extrude in the opposite direction to create a hole.    

 

 

• Right-click or press Esc to exit the tool.    

• Check in the Model Browser if a new part was created    
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Repeat three times working steps from before and create 3 more parts, for each one of the upper holes.    

 

 

   

• Check in the Model Browser if three new parts were created    

• Using the Model Browser, change the colors of the created parts.    
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Rename the created parts according to figure below 

 

 

• Click on the material button in the toolbar, within the structure ribbon, and check if the material Steel (AISI304) is 

attributed to all parts.    
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• Click on the Symmetry button in the toolbar and select the option Symmetric.    

   

 

  

• Select the supporting plate and unselect (XY) and (XZ) planes.    
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• Right-click or press Esc to exit the tool.    

• Click on the Shape Controls button in the toolbar and select the option Single drawing.    

   

 

   

• Select the supporting place and activate the (YZ) axis.    

   

 

    

• Right-click or press Esc to exit the tool.    

• Click on the Loads button in the toolbar    
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• Click in the inner surface of the Lock (part) and apply 200 N in Y direction.    

     

 

• Click again in the inner surface of the Lock(part) and apply -100 N in Z direction.    

 

 

• Click in the inner surface of the Security_Lock (part) and apply 200 N in Y direction.    
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• Click again in the inner surface of the Security_Lock (part) and apply -100 N in Z direction.    

 

  

• Click in the inner surface of the Hook (part) and apply 250 N in Y direction.    
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• Using the Model Browser, rename the created forces according to the direction and place of application.    

   

 

                                                     

• Using the Model Browser create a new load case    
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•   Select the forces applied to the Security_Lock and drag and drop to the new Load Case  

 

• Using the Model Browser right-click on the load applied to the hook and include this load in the second case 

load.    

 

• Click on the Apply Supports button on the toolbar    
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• Select the inner surface of the connection (part). Note that, in this case study, the support should be able to 

rotate around the global x axis. However, such condition would lead to a non-linear problem where the position 

of the part would depend on the applied loads and several iterations should be performed before reaching an 

equilibrium state. To simplify the analysis a fully constrained support was chosen.    

 

 

Right-click or press Esc to exit the tool.    

• Using the Model Browser right-click on the applied support and share it with all loading cases.    

• Click on Measure weight button in the toolbar    

 

• Click on the lateral_support (part) and check the weight of the part.    

• Right-click or press Esc to exit the tool.    

• Select the lateral support (part), right-click on the part and check the option design space    
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• Right-click or press Esc to exit the tool.    

• Click on the Unit System Selector and set the default unit system to SI (m kg N Pa).   • Click on the Optimize 

button in the toolbar    

 

• Select Maximize stiffness as objective function. Define the target mass as 5.0 kg, include a thickness constraint 

of 0.01 m and include both loading cases in the analysis    
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Optimization set-up  

 

• Visualize the results from the topology optimization.    
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• Right-click or press Esc to exit the tool.    

 

Recommendations  

Click on Analyse to understand the structural performance of the current concept suggested by Inspire for the same loads and 

constraints   
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Click on Fit to create a smoothed geometry over the design concept to take to CAD and fine tune the shape   

 

 

 

You can now postprocess this geometry in any other CAD system, e.g. Evolve. Recall and understand the difference and 

advantages the Simulation Driven Design Process offers:  

Your project task - design a (competitive) towing hook - starts with an optimized design concept which reduces the tedious 

and costly trials and errors to a minimum.    
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8.6  Exercise: Design of A Bracket  

 

(By Sanjay Nainani)  

 

 

Objective:   

Find the stiffest design with respect to the given loads and constraints, but use only 30% of the initial volume/mass.  

The first part of this exercise is about sketching the base geometry (shown above).   

You can skip this part by opening the model file directly:  Click Here  

• Change the unit system to ‘mm T N s’.    

• Choose the Geometry ribbon, select Polyline and draw the lines as shown below. As we cannot enter angles 

directly, we must draw a temporary line vertically 150 and then horizontally 200 and then join the ends and 

then delete the temporary lines  
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•  Click on Push/Pull and type in 100mm, confirm it with Enter.  

 

   

• Select the Circle by Centre and Point Tool from the modelling toolbar. Pick the bottom face of the solid for the 

sketch.    

 

• Draw the circle as in the picture (D=30mm)   

 

 

   

• Use the Push/Pull function to trim a hole through the solid up to a depth of 20mm.    
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• Repeat it at the other three corners. The results should appear like this:   

 

 

• In the Geometry ribbon, go to Partition. Partition helps us to create non-design spaces on which we can apply 

forces and constraints, so that we don’t have to apply them on design spaces.  

 

 

• Select all holes.    
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• Next click on Partition All.    

 

 

 

• Toggle between +/- so as the partition takes place towards inside.    

• Enter the value 5mm  
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• Right click to exit the tool. The model should look like this now from the bottom.  

 

 

 

• Select the Rectangle by Corners tool, click on the side of the model which is shown below and don’t forget to 

“create new part”.    
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• On the screenshot below you can see the correct position and the right size of the rectangle.    
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• After pulling the rectangle 50 mm. 

   

 

 

• Now draw a circle on the front face that fits exactly into the rectangle (D=30mm) and extrude it 3 mm to form 

the part for the application of force.    
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• After this, draw a second circle of diameter 14mm on the new extruded face of the little cylinder. The centre 

should be at the same position as the circle before 
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• After pulling the new circle through the whole solid, repeat the steps above to get the same result:    

  

 

  

  

Properties   

Before we can run the optimization, we must define the design space, the material, the loading, the forces, and 

manufacturing constraints. So, let`s start with defining the design space.    

• Right click on the building block and select Design Space.    
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• Right click on it again and choose Material --> Aluminium (2024).   

 

 

 

• At the next step, we will define the loading. Therefore, go to the structure ribbon and click on Apply Supports. 

Select the bottom side of the cylinder.    
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• Now we must define the forces on the top (F=10000 N each)   

 

    

 

 

 

 

 

  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  179   

 

• We want a symmetric result, because it looks better and it`s easier to produce a symmetric product. Click on 

Shape controls --> Symmetry --> Symmetric.    

 

 

• Select the Design Space and choose the mirror planes. Red planes are selected and grey planes are 

unselected. In this case we should select this plane:   

 

 

  

• To check the model, the load cases and the shape controls you can go to   View -> Property editor   

• Now we can run the optimization. Click on Run Optimization.    
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• Make sure the settings are as below and that the minimum thickness constraint is 40 mm   

 

 

                            Optimization set-up: max. stiffness for mass target 30%  

  

• Just set the Total Design Space Volume to 30% and click on run. When the solver has finished, a green flag 

appears on the optimize icon.    
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• Before you are going to view the results, take a moment and sketch your ideas (if not done already). Then click 

on the green flag it to view the results.   After the optimization run is completed, depending on your settings 

and dimensions of course, your model would look like this:  

 

  

                

  

• Click on Analyse from the Shape Explorer window to see the displacement performance of the design    
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Displacements   

  

The von Mises Stress performance of the design    

 

 

Von Mises Stress  

  

• Click on Fit in Shape Explorer Window in Optimization panel to Fit a smooth surface over the generated shape. 

The resulting surface model can then be exported to most CAD systems.  
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You can now take this smoothed geometry to your CAD tool to create your final geometry.   

You can also use the polyNURBS to create NURBS which is a new modelling method that allows you to trace over 

optimized results with precision, ease, and efficiency.  
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The tools used here to create the NURBS were:  

• Wrap to create NURBS around the structure  

• Bridge to join the NURBS created from wrap tool  

• Sharpen to sharpen the faces   

This new modelling method allows you to easily trace over optimized results to create a smoother, watertight NURBS 

version of the STL geometry. The resulting model can be exported to other CAD systems and is readily usable for 

manufacturing.  

Your model can look like this depending on your optimization settings.  
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8.7 Exercise: Concept Design Of A Street Lamp  

(original tutorial updated by Sanjay Nainani and Rahul Ponginan)  

 

  

Objective: 

Find a weight optimized design of a stress lamp.  

You may start this exercise by creating the respective base geometry with Inspire.  

Alternatively, you may open the given geometry file directly.  

Model file:   

Click Here  

• Set the unit system ‘m Kg N s’  

  

Building the geometry  

• Select Rectangle by Corners and draw a rectangle with the side lengths 2m and 0.3m.   
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• Click on Push/Pull and select the Rectangle. Type in the field 1m.   

 

  

 

• Confirm it with Enter.    

• Click on Rectangle by Corners again and select the left side of the building block.  

• Then choose Sketch on a New Part.    
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• Draw a rectangle from the left upper corner along the surface of the building block. Type in 0.3m for both 

lengths.     

  

  

  

  

 

 

 

 

 

• Pick the Push/Pull button and select the new rectangle. Type the extrusion length 0.4 m in the field. Now it 

should look like this:   

 

 

• Repeat the previous steps on the other side of the building block. These two new parts are the alternatives of 

the lamps.   

• Pick Circle by Centre and Point. Choose the bottom side of the big building block for drawing the circle. Select 

Sketch on a New Part. Draw it on the centre of this side and type in the radius 0.1 m.   
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• Extrude this circle with Push/Pull to a length of 0.2 m. This cylinder is needed for the loading (like a normal 

lamp post). Quite obviously, the chosen diameter of the post is rather small --> you may change it in a follow-

up study on your own ...   

 

 

 

Properties   

Before we can run the optimization, we must define the design space, the material, the loads, etc. So, let`s start with 

defining the design space.    

• Right click on the building block and select Design Space.    

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  189   

 

 

   

• Right click on it again and choose Material --> Aluminum (2024-T3).   

 

   

• At the next step we will define the loading. Therefore, click on Apply Supports.  Select the bottom side of the 

cylinder.    
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• We apply a rather arbitrary load on the lamp acting in vertical direction only (what about wind loads etc.?).  

--> Pick Apply Pressures and choose the bottom side of one of the smaller building blocks. Type in 1000 Pa and do the 

same with the other block.    

  

Be sure that you define the right direction for the pressure! You can change the direction with the button +/- (Question: can 

we always expect symmetric loading?).  

Next, we define manufacturing constraints with the intention to create a symmetric lamp.   

• Click on Symmetry -> Symmetric.    
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• Select the design space and choose the planes, i.e. red planes are selected, and grey planes are unselected. 

In this case we should select these two planes:   

 

 

To check the model, the load cases and the shape controls you can go to View -->  

Property editor or press F3 on the keyboard  

• Now we can run the optimization. Click on Run Optimization.    
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• Just set the Total Design Space Volume to 35% and click on run. When the solver has finished, a green flag 

appears on the optimize icon.    

• Click on it to view the results.    

 

After a successfully optimization, depending on your own settings, the model could look like this:   
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Note: Gray color indicates non-design space. Brown: design space. There is a jump in the geometry marking the boundary 

between design and non-design space. Aside from looking somewhat weird such jumps should be avoided. A smoother 

transition between both areas would be preferred. Hence, either by making the lower truss thinner (removing material) or by 

adding a sort of fillet to the non-design space  

(adding mass). What is the better solution? To answer this question, you may should modify the model accordingly in a 

follow-up study ...  

 

 

 

 

 

  

• Re-run an analysis on the optimized structure  

• (see below) to understand the stress level (and displacements). If the stresses in the truss are low you might 

consider removing some material (to create a smoother transition)   

• Click on Analyse to see the performance of this design concept for the applied loads    
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• Cross check the stresses and displacement. Also note that the proportion (thickness) of the pillar (i.e. small 

“stud”) does not really fit to the dimension of the lamp. Hence, we suggest as a follow up to this exercise to 

modify the dimension of the stud as well as the aforementioned transition from design to non-design space.  

• Click on Fit to create a smoothed model to take to CAD   

  

  

   

Alternatively follow the procedure below to modify with Altair Evolve, meaning to export the geometry to Evolve.  

• Right click on the optimized part and select Save to Evolve.   

 

 

• Open Evolve and choose Retrieve from Inspire. Your model will be directly loaded into Evolve   
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Now you can use the modelling tools for getting a manufacturable product.    

  

Again, try different settings and see how the design will change.    

 

 

8.8 Exercise: Re-Design of A Support Arm  

(Written by Jacob Tremmel and Rahul Ponginan; updated by Sanjay Nainani)  
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Objective  

Re-design a simple support arm by employing topology optimization in Altair Inspire (i.e. find a more lighter design solution).  

Note that all model assumptions such as original design space, loads, materials etc. are purely conceptual.   

Before you fire up Inspire make up your mind about the existing design. Can the design be changed at all (its outer geometry 

must remain as is)? Where would you change the design; Why?  

• Set the unit system to ‘m Kg N Pa’ or ‘cm g dyn ba’ as required.    

• You may create the initial geometry in Inspire next or open the given model directly in Inspire:   

              Click Here  

 

Geometry sketching:    

• Let`s begin with a sketch on the XY plane.  Make sure the Geometry Tab is activated,   

 

• Click on the Arc by Centre and Ends sketching option as shown below.    

 

• This action switches the screen to the sketching mode, recognizable on the grid in the background.    

• Draw three-fourth of the circle as shown on the right.   
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• First click on the origin for centre of the arc, then choose the start and end points at grid points as shown 

below,   

• Be sure to enter the values for radius: 5cm; angle: -270°     

• Notice: You can use the grid lines for start and end points.     

• Use the ‘line’-tool to close the circle.     

 

 

You can quit the sketching mode by a right mouse click.    

As Inspire realizes that sketching mode is finished, it switches into the ‘Push/Pull’- mode automatically.    

• Either click the side face and enter the thickness ‘2 cm’ or click (and hold) the left mouse button and push the 

face until it assumes the desired thickness of 2cm.     
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• Now click the‚ Line symbol at the toolbar and select the side face to enter the sketching mode again.    

Next, we will draw the arm of the support.    

 

 

 

Attention  

• Click on the small symbol named ‘Sketch on a New Part’ before you draw your first line. Otherwise the new 
sketch would be merged to the old one. As we only want the upper part to be ‘Design space’, this would not be 
our aim.   

 

length:  20 cm                                   length:  20 cm 

 

• Go on drawing two straight lines as shown in the two images.    

• Click on the start point and end point and enter the desired dimensions as shown above.   
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To make sure that these two lines are perpendicular to the highlighted edge (see image below)   

 

... a new line (as we did to close the circle before) needs to be created   

  

• Click on the first line and then right click the second line which are supposed to be perpendicular to each other 

and select the corresponding icon (shown below).   

 

• Now click on the first line then right click on the second line, then choose the parallel lines option as shown 

below to make them parallel.   
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• Pick the “Arc Tangent to End” symbol to continue/extend the lines tangentially.    

Notice: It will be enough to take over the contour approximately.    

  

 

     

 

Radius 24 cm, angle 450                                         Radius 15 cm, angle 450 

  

  

Remember to right click after each step and start fresh.    

• Close the end with line as shown below.   
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• Pull/extrude the new area to get the model shown below.   

  

 

• Click online and select the top face and click on new part as before, 

• Now draw a line as we did to close the end to start our next part,   
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•  Draw two lines to continue the arm with 15 cm length, make the lines parallel and perpendicular.   

 

 

• Close the ends and then push pull.   

   

 

• Start with a continuation line (like the one we used to close the rectangle before) and then draw a 2-cm line 

that is collinear to the starting line)   
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When making the lines collinear make sure to select the longer line first and the shorter line next.    

Create the following shape with the following dimensions approximately.    

 

 

   

• Push pull again, you will now have a geometry like this.    
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• Click on Boolean + symbol and combine all the parts except the circular part.    

 

 

So now you have two parts  

 

 

However, we forgot to cut out the hole for our constraint. 
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As Altair Inspire allows editing of the volumes at any time, no harm was done.    

• Select the circle option and the top face of the circular part, to create a circle of  

• 4cm, make sure you do not select sketch on a new part this time,    

 

 

• Right click outside to enter the push pull mode, then push the circle to create a hole   

• Select the symbol named “Materials” in the Structure tab, the “Parts and Materials” window opens, all the parts 

and materials are listed, including the allocated materials.    

• Select the different parts and select any materials you like. Here we (arbitrarily) use Steel for both.       

Notice: It is also possible to create your own material. To do so, switch to the Tab ‘My Materials’, click on the ‘New’ (plus) 

icon and enter the different physical properties, such as E-Modulus, Poisson’s ratio, Density and Yield Stress.   
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• Select the arm part and click with the right mouse button on it. Enable the checkbox named “Design space”.    

   

  

   

• The upper part should now appear in a dark red color. See next image  
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Notice: Any optimization of volume or mass needs a definition of the design space, the free space in which the optimizer can 

remove material.    

In this case the circle part at the bottom is mandatory. Hence it must not be defined as “Design Space”.    

Usually you define the loads and constraints next.    

  

  

Loads and Constraints   

Next, constraints will be defined.   

• Pick the icon named “Apply Supports” and select the cylindrical hole (the inner surface)   
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The surface will be marked as fixed bearing. 

 

Notice: You can change the kind of bearing inside the pop-up panel that appears as soon as the support is created. 

    

• Click the icon titled “Apply Forces” and select the faces as shown in the images. Do not forget to type in the 

magnitude 100 N, 50 N and 20 N.  Also check the force direction.     
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There is a possibility to organize the loads and constraints in multiple load cases. Click the icon named “List Load Cases….” 

The first load case was created automatically and includes all defined forces and constraints. 

The different entities can be turned off via the checkboxes.    
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Additional load cases can be added by activating the “+” symbol as indicated below.  

The various load cases can then be considered in the optimization run.   

 

 

At this point the optimization set-up is complete and the optimization run can (or could) be started.    

Optionally (and additionally) to ease manufacturing, symmetry conditions may be defined.   

To define symmetry, pick the icon entitled “Symmetry” and unselect all symmetry planes which are not needed. Here, the 

symmetry plane is the XY-plane.    
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In addition, draw direction constraints may be defined (also to ease manufacturing).  Choose the icon named “Draw 

Direction” and click on “Single Draw” in the sub-menu. Then select the model (=arm). The draw direction will be 

automatically displayed. 

 

 

 

 

Optimization   

Finally, we start the optimization run.    

• Click on the symbol named “Optimize”   

The “Run Optimization” panel opens up which allows defining optimization settings as shown in the image below.   
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After launching the optimization, the optimization run status is displayed (green bar).   

 

 

 

Notice: Ignore and click continue on the warning about loads applied to the design space, in general loads must not be 

applied on the design space.     

After the optimization is completed, a green flag is shown.    

 

• Click on it to load and view the optimization results.   
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• Clicking on the optimized “arm” opens another pop-up window which allows to view the optimization results of 

different optimization runs (here only a single run). By moving the slider, material may be added/removed 

(which corresponds to a personal interpretation of the result).   
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How to go on from here?   

• Hopefully, you can answer this question yourself (similar steps have been carried out in the previous 

exercises): Click on Analyse to see the displacement performance of the design ...  

 

Displacements  

  

  

Concept design proposal  
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Von Mises Stress  

  

  

Click on Fit to smooth the design and create a solid best approximating the design.    

 

 

   

You can save the model to any required format. 
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Use the modeling tools in your CAD tool to retrace the arm support according to your interpretation and “understanding” 

taking into account manufacturing aspects.    

  

  

8.9 Exercise: Topography Optimization Of An L-Bracket  

Objective:  

This tutorial focuses on the topography optimization of an L-bracket modeled with an attached concentrated mass. The 

objective is to maximize the frequency of the first mode by introducing beads or swages to the bracket. Objective formulation 

applied: maximize stiffness  

Model file: Click Here  

 

 

• Load the model Start.stmod, set the unit system to mm, t, N, s  

• Review the model (thickness) and the materials assigned in the Materials --> Parts and Materials Parts  
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To review the material properties in more details, activate the Material Library Tab  

 

 

Create Boundary Conditions  

Select Apply Supports from the Loads icon located in the Ribbon in Structure Tab  
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Select the circular edge of the hole to create a support; similarly create supports at the remaining holes.  

  

 

Create Loads  

Select Apply Force from the Loads icon located in the Ribbon in Structure Tab  

Enter 50 N, X direction for the Force  

 

 

Create Concentrated Mass  

At this point you may wonder what a “concentrated mass” is about. Imagine, another component / part is attached to the L-

Bracket. The weight of the attached part quite obviously affects the way the L-Bracket will vibrate (perform). However, we 

are not interested to understand (analyse) how the attached part behaves. Hence, the attached part is simplified by just 

concentrating (and adding) its mass at the location where the part is attached to the L-Bracket.   

Select Masses located in the Ribbon in Structure Tab  
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• The concentrated mass will be located (attached) to the existing Point 1.   

• Select the inner edges of the circular hole displayed  

• Enter 0.0005 t for the mass  

 

  

Steps to run the analysis:  

• Let the element size be default 1 mm  

• Expand the normal Modes and select 10  

• Select Load Case 2 for the Use of supports from Load case  

• Select Faster for Speed/Accuracy  

• Select Sliding Only for the Contacts  

• Click run  

 Select Show Analysis Results  
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                                           Max displacement                                                                Stress  

 

 

 

 

 

 

 

 

 

Normal mode  
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Setting up Optimization  

Design Space  

Right click the part ‘Part 1 Slice 2’ and click on Design Space  

 

  

 

Shape Controls  

Select Add/Edit Shape Controls in Shape options in the Structure tab in the Ribbon  

 

 

Select the XZ plane and the YZ plane to disable it and to create a symmetry along X axis   

 

Start Topography Optimization Run -Minimum Bead Width 15 mm  

• Click on run optimization  

• Select Topography as a Run Type  

• Bead options: width 15 mm, angle 75 deg, max depth 5 mm  

• Select maximize frequencies and verify Load Case 2 is selected.  

• Frequency constraints --> use constraints from load case   
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Load the Optimization Results - Minimum Bead Width 15 mm 

Load the Optimization Results and click on analyse  
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Load the analysis result of the optimized shape (minimum Bead Width 15 mm) The displacement has reduced from 0.66 mm 

to 0.48 mm     

 

 

The frequency for first mode has increased from 71 to close to 83 Hz  

 

 

  

Topography Optimization Run - Minimum Bead Width 10 mm Change the name to Start_10mm, change the minimum width 

to 10 mm.  

Leave all parameters same as for earlier optimization and click Run.  

Load the Optimization Results (minimum bead width 10 mm), then click on Analyse  
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New (topography) shape  

  

The displacement has reduced further from 0.48 mm to 0.32 mm  

The frequency has increased further from 83 to 100 Hz  

      

  

                                               Frequency (1 mode)                  Displacements   

 

Topography Optimization Results – Minimum Bead Width 5 mm  

Of course, you need to run the updated/modified model first. Then load the optimization results  

The Displacement has reduced further from 0.32 to 0.158 mm  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  226   

 

The first eigenfrequency (mode 1) has increased further from 99 to 141 Hz  

                                                                   

                                         New (topography) shape                 Displacements  

 

 

Frequency (mode 1)  

  

Before you can create the Comparison Table, save the model.   

Click on Compare Results  
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Use arrow at the top of Compare to adjust the available space  
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9.  Capstone Project: Re-Design Of A Door Hinge  
 

(Tutorial by Sanjay Nainani)  

The following capstone project is quite comprehensive. It includes substantial geometry creation work (model will be built 

from scratch within Inspire), the classical analysis set-up, and optimization. The optimization is about maximizing its stiffness 

by using 30 % of its initial volume/mass.  

The “final” concept design may then be smoothed in Evolve or any other CAD system and reanalyzed in Inspire again. 

Hence this project is suited as a homework assignment or a student project which runs in parallel to the design class at the 

campus.  

 

 

 

In case you want to leave the geometry building chapter aside, you can download the model file from here:  

Click Here  

 

Geometry building  

• Set the unit system to ‘m Kg N s’.    

  

Centre Part   

• Use the Arc by Centre tool to draw the sketch in the image:   
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• Push/Pull the surface to 340 mm  

 

 

  

• Rename the part Centre in the Parts and Materials window.  

 

Right Side of The Hinge   

• Double click on one of the rectangular faces on the Centre part.   
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Once in Sketching Mode, create a new part and use the Convert Reference Lines to Sketch tool to create sketches from the 

existing part.   

 

 

 

• Pull the surface to 260 mm.  

 

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  231   

 

• Rename the part to Right in the Model Browser.   

 

Round Packet on The Interior Face   

• Use the Sketch Mode to create a circle using the Circle by Centre and Point tools.  

The circle will have a diameter of 80 mm.  

 

  

• Use the Push/Pull tool to create 15 mm deep circular pocket.   
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• Create a sketch in a new part as shown in the image:   

  

  

  

  

  

  

  

  

  

  

  

  

  

 

 

 

 

 

• Pull the new part to the same thickness as the right part.   
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Rename the new part Right non-design.   

• Use the Right Non-Design Part to Cut the Right Part   

• Use the Subtract tool to cut the right part.   

Hint: Make sure to activate the keep option to retain the right non-design part. 

   

 

  

• Create two rectangles and a polyline on the right non-design part.   

  

 

Create two additional rectangles   
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• Use the Trim tool to remove the left-hand side both rectangles attached to the polyline.   

 

 

Hint: You will need to do it twice, once for the rectangles and once for the polylines.   

Pull both rectangles and the polygon all the way through.   
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• Draw the sketch in the image in a new part on the top surface of the right non design part.   

 

• Pull the sketch to extend to the bottom of the second block.   

  

 

  

Use the subtract tool to give the rounded shape to both blocks.   
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• Repeat the process on the middle blocks and then on both bottom blocks.   

• Create a circle in a new part on the top face of the Right non-design part.   

 

                            

• Pull the circle all the way through the part.   

• Create similar holes in the middle of the part.   

 

 

 

 

 

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  237   

 

Left Side Of The Part   

• Using the Polyline tool, select the other rectangular side of the Centre part.   

  

   

• Use the Plane Selector tool to change the plane and align it to where we want to create the new part.   

• Sketch the new part as shown in image.  

 

Notice the surface is not connected; move it to be connected to the Centre part.  

Use snapping to align the surface.    

• Pull the surface to be the same thickness as the Center part.   
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• Rename the new part as Left.   

• Create the sketches in the image on the Left part.   

  

   

• Pull all 4 shapes through the part.  
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• Create the Left non-design part using the same process as the Right non-design part.  Note that there are only 

four supports.   

  

  

 

  

Create A Hole in The Middle   

• Use the Isolate tool to isolate the centre part.   

• Use the Rectangle by Corners tool to create a rectangular sketch.  Make the sketch 60 mm high and wide 

enough to encompass the entire part.   
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• Pull the surface completely through the part.   

 

 

  

• Use the Subtract tool to remove the middle of the Center part.   
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• Show all the other parts.   

  

 

Create A Hole In The Left Part   

• Create a 16 mm hole in the left part as shown in the image.   

 

  

Supports / Constraints  

• Create the Supports on the Left non-design side   

• Use the Support tool to create a support in the bottom most hole on the left side.   

• Create an additional support in the second topmost hole.   
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• Click the orange cylinder to change which directions are locked and free.   

• Click both transparent arrows to enable movement in the direction they represent.   

 

 

They will turn green as you click them.   
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Create Loads on The Part   

• Create a force in the –y direction with a magnitude of 1,800 N in the circular pocket on the Right part.   

 

 

• Create one force in each of the cylindrical holes of the right non-design part.  Give them all a magnitude of 

1,800 N and the following directions from top to bottom: Z; Y; -Y; Z.   

•  
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Design Space  

• Right click on the following parts and select them as Design Space  

 

 

Organize the Loads into Load Cases   

• Open the List Load Case tool.   

• Create a second load case.   

• Activate both supports in both load cases.   

• Activate the loads in load cases 1 and 2 as shown in the image.   

 

  

Setup for Optimization   
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• Right click on each of the Left, Centre, and Right parts and select Design Space. All three parts will turn a 

brownish color.   

 

 

Setup Shape Controls on The Model   

• Click the Draw Direction tool in Single Draw mode.   

 

• Click the left part.  A draw direction plane is created in blue along the main plane of the part.   
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• Click the +/- button on the mini toolbar to reverse the direction to make it go outwards.   

 

                 

• Repeat the operation on the right part.   

• Click the Draw Direction tool in Single Draw mode.   

• Click on the Centre part.     

 

                                                    

The parting direction is not in the desired direction and we will need to rotate it.   

• Click the compass symbol in the mini toolbar.   
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• Select the arc going between X and Y to rotate around the Z-axis and enter 45 deg as the value.   

 

 

• Click the +/- button on the mini toolbar to reverse the direction to make it go outwards. 
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Run the Optimization   

• Open the Optimization tool.   

• Set a Mass target of 30% of the total design space.   

  

  

  

  

  

  

  

  

  

  

  

  

 

 

 

 

 

 

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  249   

 

Run the Optimization  

(this will take several minutes.)   

(It will show a warning that WE HAVE APPLIED LOAD ON DESIGN SPACE, we can ignore that so click on CONTINUE)  

You will see a green tick in the Optimization Run Status when the job is complete. Display the results from the dialog. 

Double click on any of the design space parts to bring up the Results window.  Explore the shapes using the Topology slider.   

 

 

In the Shape Explorer Toolbar click on Fit to create a smoothed model to take to CAD  
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At that point, we leave you “alone”:  

You may redraw (smoothen) the geometry above and run an analysis to (virtually) test this design.  

Curious to see your final results.  
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10. Cap Stone Projects: The Virtual Bike Project  
  

 

 

 

 

 

 

 

 

 

 

 

 

The Virtual Bike Project “circles” around the Simulation Driven Design Process. We consider it as a learning and teaching 

project as our solutions are by far not complete nor perfect. We provide just a first variant, which may also be considered as 

a kind of introduction.  

The design of the bike involved various CAE disciplines as depicted in the image and listed below:  

 

https://altairuniversity.com/conceptual-design-of-a-3-wheeler-motorbike/  

 

Available project data:  

• CAD - Sketching (Evolve)  

• Multibody Simulation (MotionView/MotionSolve)  

• Crashbox Design (RADIOSS)  

• Stone Impact (RADIOSS)  

• Composite Analysis & Optimization (OptiStruct)  
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• Antenna Design and Placement (FEKO)  

• Topology Optimization (Inspire)  

• Topography Optimization (Inspire)  

• Aerodynamic Simulation (Virtual WindTunnel)  

• Aerodynamic Testing (physical windtunnel)  

• 3D FDM Printing  

• Rendering (Evolve)  

The individual projects and associated working steps were video recorded. All the model files are available for download (on 

the respective project website; see below).   

And again, always ask yourself how the given solution(s) may be improved!  

  

 

10.1 Battery Tray Topology Optimization  

 

(Prepared by Rahul Rajan)  

 

  

The battery tray is part of the three-wheeler bike, made of thin sheet metal. We carry out static analysis & topology 

optimization for given loading conditions on the sheet with a thickness constraint of 10 mm (i.e. member thickness - not 

sheet metal thickness). We achieve mass reduction from 3.68 kg to 1.79 kg.   
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Objective:   

Maximize stiffness and use 30 % of the initial volume/mass.  

  

Project related model files:  

Click Here  

  

A project summary is provided in the following recording:  

  

 

https://altair-2.wistia.com/medias/njtv0jb6xu   

  

Material & Property definition  

• Set unit system to MPA.  

• To define material & thickness, use Structure ribbon>Setup toolbar>Materials   

  

We use (Steel AISI 304) from the Inspire material library.  
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Loads & Boundary Conditions  

We apply supports to the model, restrict all Degrees of Freedom (DoF) for bosses. Use  Structure ribbon>Setup 

toolbar>Loads. We apply force named F7:100 N, F8:100 N, F9:800 N, F10:400 N & F11:141 N organized in to loadcase X 

(F7, F8, F10&F11) & loadcase Z (F7, F9&F11).  (Refer the video)   

 

Battery tray (base design) with support & pressure applied  

  

Run Static Analysis  

To carry out static analysis, we chose below settings:  
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Static Analysis Results (Run1)  

 

 

          Displacement 0.53 mm                            max. von Mises stress 133 Mpa  

  

 

Settings Used for Optimization Runs  

• Define design space.  

• Run2 Battery tray with mass target 35% & 5 mm thickness constraint.  

• Run3 Battery tray with mass target 35% & 10 mm thickness constraint.  

 

Battery tray with design (dark brown) and non-design region  

  

  

Start Topology Optimization Run3 (Mass Target 35% & 10 mm Thickness Constraint)   

To carry out optimization for Run3, we chose below settings:  
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     Run3: Displacement 0.72 mm, max von Mises stress 156 MPa  

  

Now you need to set-up and run “Run2 - Battery tray with mass target 35% & 5 mm thickness constraint”.  

It should be straight forward as the changes have to be made in the “Run Optimization” panel only.  

Once RUN 2 and Run3 are completed, save the model file and open up the Comparison Table.  
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Compare Results Table for Analysis & Optimization  

• From Shape Explorer launch compare results table  

 

Max displacement and max. mass  

  

 

 

Mass of baseline design is 3.68 kg versus optimized design mass 1.79 kg (thickness constraint 10 mm) and 1.68 kg 

(thickness constraint 5 mm).  

  

 

 Fit Optimization Output  

• To derive the geometry from the optimized design, go to Shape Explorer and run “Fit surface over the shape”.  

 

  Baseline design mass is 3.68 kg       Final optimized design mass is 1.79 kg  
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10.2 Wheel Rim Topology Optimization  

(Prepared by Rahul Rajan)  

 

                                                   First sketch                       Optimized design  

 

The Wheel Rim of the three-wheeler bike was modelled using Altair Evolve. We use Altair Inspire for topology optimization 

and use cyclic symmetry constraints to create a symmetric result. Stress constraints & mass targets are used to achieve 

optimal designs, which suits given loading conditions. By carrying several runs, we find that cyclic symmetry with 5 sectors, 

split draw, and default thickness constraint yields a suitable design output. We can achieve a mass saving from 4.6 kg to 2.9 

kg. We see further scope of topology optimization on the optimized structure using various other Inspire options. We 

encourage to try out the best possible combinations of manufacturing constraints to come up with new designs.  

  

Objective:   

Find an inspiring weight optimized design of a wheel rim.  

  

Project related model files:  

Click Here  
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A project overview is provided in the recording below:  

  

 

https://altair-2.wistia.com/medias/uv1mvglion  

 

 

https://altair-2.wistia.com/medias/88j1s25o6p  
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https://altair-2.wistia.com/medias/pq3bsjj66y  

 

 

https://altair-2.wistia.com/medias/8ozlz09xd2   

  

Material & Property Definition  

• Set unit system to MPA.  

• To define material & thickness, use Structure ribbon>Setup toolbar>Materials We use (Aluminum 7075-T6) 

from the Inspire material library.  
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Loads & Boundary Conditions  

We have considered pressure & bending load cases for wheel rim.  

• Apply supports to the wheel hub centre for pressure load case, Cylindrical support will fix all DOF automatically 

& restrict all DOF for vertical inner face of wheel rim for bending load case. Use Structure ribbon>Setup 

toolbar>Loads  

Apply pressure of 0.2 MPa on face of wheel rim for pressure load. Maximum pressure considered for fat tires is 30 Psi (= 0.2 

MPa) & force of 4070 N on cylindrical face of wheel hub -Z direction. Weight of the vehicle is roughly considered to be 300 

Kg (3000 N) + weight of driver & pillion as 1070 N.            

How the loads are applied:  
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        Pressure          Support 1  

 

                                                    

        

 

 

 

     Support 2                                                               Support 3  
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Run Static Analysis  

To carry out static analysis, we chose below settings:  

  

  

  

  

  

  

  

 

 

 

  

 

 

 

Static Analysis Results (Run1)  

Displacement & von Mises stress for bending loadcase  

 

                                         Displacement: 0.002 mm                    Max von Mises stress: 2.2 MPa   

          

  

Various Setting Used for Optimization Run   

• Delete initial design holes to provide maximum design space for optimization. Use Geometry ribbon>Modify 

toolbar>Simplify>Holes  

• Define design space, split draw & cyclic symmetry with 5 sectors.  

• Run3 Wheel rim with mass target 30% & 17.82 mm thickness constraint.  

• Use output of Run3 Wheel rim with mass target 30% & 12 mm thickness constraint for final optimization run.  
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Wheel rim with split draw direction & cyclic symmetry for Run3 & final optimization run  

 

Start Topology Optimization Run  

To carry out optimization for final run, we chose the following settings:  
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Final Run Wheel Rim With Mass Target 30% & 12 mm Thickness Constraint  

Displacement & von Mises stress for bending load case  

 

   Displacement: 0.018 mm                            max Von Mises Stress: 29.6 MPa  

 

Compare Results Table for Analysis & Optimization  

From Shape Explorer launch compare results table  

 

Mass of baseline design is 4.61 kg & optimized design mass is 2.31 kg  

  

  

Fit Optimization Output  

•  From Shape Explorer run “Fit” to generate fit surface & save it as Parasolid format.  

  

PolyNURBS Fit Surface  

PolyNURBS allow you to quickly create free-form solid geometry that is smooth and continuous. The resulting model can be 

exported to other CAD systems and is readily usable for manufacturing. Use Geometry ribbon>Create toolbar>PolyNURBS  
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Final PolyNURB design is 2.45 kg  

 

 

https://altair-2.wistia.com/medias/8ozlz09xd2  
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10.3 Oil pan Topography Optimization   

(Prepared by Rahul Rajan)  

 

Oil pans are major engine cooling system parts. They are usually constructed of thin steel and shaped into a deeper section 

to fully perform its function. When an engine is not running or at rest, oil pans collects the oil as it flows down from the sides 

of the crankcase. In other words, oil pans that are mounted at the bottom of the crankcase serves as an oil reservoir. Engine 

oil is used for the lubrication, cooling, and cleaning of internal combustion engines. At the bottom of the pan is the oil drain 

plug that can be usually removed to allow old oil to flow out of the car or bike during an oil exchange. After the used oil 

drains out, the plug is screwed back into the drain hole. Drain plugs are often made with a magnet in it, collecting metal 

fragments from the oil. Some contain a replaceable washer to avoid leakage caused by corrosion or worn threads in the 

drain hole.  

Here in this project we used Altair Inspire for topography optimization. We carried out topography optimization with 

maximum design space & used the linear bead type with draw direction to get beads on upward & downward directions. 

Output of downward beads compared most efficiently to baseline design than beads on upward direction, but we consider 

beads on upward direction as the reliable design because of the flat portion of the oil pan base. Beads on downward 

direction would be ideal when we have curvature on oil pan base enabling oil to flow out without hindrance.  

Objective:   

Find the best bead pattern to increase the stiffness of the oil pan (without adding additional material).  

  

Project related model files:  

Click Here  
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https://altair-2.wistia.com/medias/8x6agnetm4  

 

https://altair-2.wistia.com/medias/zb51in7a8y  

  

 

Material & Property definition  

• Set unit system to MPA.  

• To define material & thickness, use Structure ribbon>Setup toolbar>Materials.  

• We use (Steel AISI 304) from the Inspire material library.  
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Loads & Boundary Conditions  

• Apply supports to the model, using grounded fasteners. Use Structure ribbon>Connection>Fasteners  

• Apply 0.035 MPa pressure on each face of the oil pan base. Use Structure ribbon>Setup toolbar>Loads  

   

 

Oil pan with support & pressure applied  
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Run Static & Modal Analysis   

To carry out static & modal analysis, we chose below settings:  

 

    

Static & Modal Analysis Results (Run1)  

 

 

Displacement: 0.159 mm; max von Mises stress: 74 MPa; first frequency: 1058 Hz 

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  271   

 

  

Settings Used for Optimization Runs   

• Define design space, use linear bead pattern & to get bead on downward direction use single draw.  

• Remove existing beads to have more design space.   

• Run2 oil pan with no bead static & modal.  

• Run3 updated oil pan with linear bead, maximize stiffness as objective & frequency constraint 1058 Hz  

• Run4 updated oil pan with linear bead, maximize stiffness as objective, frequency constraint 1058 Hz & single 

draw on downward direction  

 

Oil pan with linear bead pattern & single draw in downward direction  

  

 

Start Topography Optimization Run  

To carry out optimization for Run4, we chose below settings:  
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Run4 Updated Oil pan With Linear Bead, Maximize Stiffness As Objective, Frequency Constraint 1058 Hz & Single 

Draw On Downward Direction  

 

Displacement: 0.093 mm; max von Mises stress: 48.9 MPa; first frequency 1377 Hz 
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Compare Results Table for Analysis & Optimization  

From Shape Explorer launch compare results table                      

 

Output of Run 4 gives best results for displacement, von Mises stress & natural frequency 

  

 

 

Fit Optimization Output  

From Shape explorer run Fit to generate fit surface & save it as Parasolid format.  

 

Final optimized shape after optimization for Run3 & Run4   

 

 

10.4 Footrest Topography Optimization   

(Prepared by Rahul Rajan)  
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This assembly of the three-wheeler bike was modelled using Altair Evolve (see respective videos for more details). Since the 

footrest panel is a thin sheet and symmetric we have considered only the left portion for analysis and optimization.   

Note: Before running an analysis or optimization we strongly recommend users to define “Run options” under “File 

preferences”. This will help to have all relevant analysis & optimization run folder in one common location for a particular 

model.  

 

Objective:   

Find the best bead pattern to increase the stiffness (maximize stiffness) of the footrest (without adding additional material).  

 

 

 

 

 

 

 

              

  

https://altair-2.wistia.com/medias/ph56hjuy0z  

  

Project related model files:  

https://altairuniversity.com/conceptual-design-of-a-3-wheeler- 

motorbike/conceptual-designof-a-3-wheeler-motorbike-footrest-topographyoptimization-with-inspire/  

 

http://altair.com/
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https://altairuniversity.com/conceptual-design-of-a-3-wheeler-motorbike/conceptual-design-of-a-3-wheeler-motorbike-footrest-topography-optimization-with-inspire/
https://altairuniversity.com/conceptual-design-of-a-3-wheeler-motorbike/conceptual-design-of-a-3-wheeler-motorbike-footrest-topography-optimization-with-inspire/
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https://altair-2.wistia.com/medias/z5nis8bufl  

 

https://altair-2.wistia.com/medias/qmxqep12kn  
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https://altair-2.wistia.com/medias/ioeb9mla9r  

 

https://altair-2.wistia.com/medias/fs57bznxc9   
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 https://altair-2.wistia.com/medias/8w0obf7qqv  

  

  

Material & Property Definition  

• To define material & thickness use Structure ribbon>Setup toolbar>Materials. We use Aluminium 2024 from 

the Inspire material library.  

• Set unit system to MPA.  

 

         

 

Loads & Boundary Conditions  

• To apply loads & boundary conditions at appropriate locations we split the footrest into smaller parts.  

• The edge of the footrest connected to the bike frame is locked completely (all dof are restricted).  

• Upon loading the footrest will tend to slightly move along z axis, hence while applying supports we allow 

translation along the z axis (edge connected to fairing).  

• To apply force of 620 N (driver weight) & 450 N (pillion weight) use Structure ribbon>Setup toolbar >Loads   
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Footrest with support & forces applied  

  

  

  

  

 

 

Run Static & Modal Analysis   

To carry out static & modal analysis, we chose below settings:  
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Static & Modal Analysis Results (Run1)  
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Displacement: 0.074 mm, max von Mises stress: 23.04 MPa; first frequency: 654 Hz 

  

 

Settings Used for Optimization Runs   

• Define design space & use linear bead pattern along the width of footrest.  

• Run2 with linear bead pattern, maximize frequency as objective.  

• Run3 with linear bead pattern, maximize stiffness as objective, frequency constraint 712 Hz.   

 

Footrest with design space & linear bead pattern  
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Start Topography Optimization Run  

To carry out optimization for Run3, we chose below settings:  

  

  

  

Run3 With Linear Bead Pattern, Maximize Stiffness As Objective, Frequency Constraint 712 Hz   

 

       

Displacement 0.059 mm, max von Mises stress 20.67 MPa; first frequency 747 Hz  
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Compare Results Table For Analysis & Optimization 

From Shape Explorer launch compare results table   

         

 

         

 

Output of Run 3 gives best output for displacement, von Mises stress & natural frequency 

  

 

Fit Optimization Output  

From Shape explorer run Fit to generate fit surface & save it as Parasolid format.  

 

Final optimized shape after optimization  
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10.5 Fender Topography Optimization  

(Tutorial prepared by Rahul Rajan)  

 

 

While the first frequency of the base design was 61 Hz (baseline design; see the respective tutorial under “Analysis”), 

topography optimization is applied to increase the first frequency 

  

Objective:   

Find the best bead pattern to increase the first eigenfrequency (without adding additional material).   

  

Project related model files:  

Click Here   

  

 

https://altair-2.wistia.com/medias/a5wfbnvs9z  
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https://altair-2.wistia.com/projects/blgjz8lgii#  

  

  

  

Material & Property Definition  

• To create material, go to Structure ribbon>Setup toolbar>Materials. Create own material using My Material.  

  

 

  

• To assign thickness select the parts from the Parts & Material tab.   

  

 

 

Connectors & Boundary Conditions  

• To create connectors Structure ribbon>Connection toolbar>Connector  

• Select the circular edge of the hole & two adjacent edge of mount surfaces to create a connector.  
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• To create constraints Structure ribbon> Setup toolbar >Loads  

• Restrict all translation DOF for two holes.  

• Restrict translation DOF along Y Axis for Fender center location.  

  

 

 

 

Run Modal Analysis   

• Let the element size be default 3.96 mm  

• Expand the normal Modes and select 10  

• Select Load Case 1 for the use of supports from load case  

• Select Faster for Speed/Accuracy  

• Select Sliding Only for the Contacts  

• Click run   
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Modal Analysis Results (Run1)  

          

  

  

  

  

  

                

 

 

 

 

 

 

First frequency 60 Hz 

  

  

Settings Used for Optimization Run   

• Define design space as fender part.  

• Run2 topography with no manufacturing constraint  

• Run3 topography with symmetry constraint   

• Run4 topography with Symmetry & linear bead pattern manufacturing constraint  

• Run5 topography with only symmetry constraint & bead parameter (width, height: 5 mm & Bead angle 60 

degrees)  

• Run6 topography with only symmetry constraint & bead parameter (width, height: 6 mm & Bead angle 60 

degrees)  
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Start Topography Optimization Run  

• Click on Run optimization  

• Select Topography as a Run Type  

• Select Objective as Maximize Frequency  

• Leave the bead options as Default as shown in the figure  

• Verify Load Case 1 is selected.  

• Speed/Accuracy should be set to Faster  

• Click on Run  

  

Run6 Topography with Only Symmetry Constraint & Bead Parameter (Width, Height: 6mm & Bead Angle 600)  

 

 

First frequency raised to 95 Hz 
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Compare Results Table for Analysis & Optimization  

 

 

Output of Run 6 gives best results for the first frequency 

 

 

10.6 Brake Pedal - Redesign  

 

  

  

The redesign of the brake pedal as shown in the video below is an excellent “component” to learn and teach FE-Analysis 

and Concept Design (topology optimization) with Altair Inspire.  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  289   

 

Objective:   

Find a better design which is as material efficient as possible.  

 

Project related model files:   

Click Here  

 

Related working steps:  

• Analyse the base design (initial design)  

• Simplify the geometry for the subsequent topology optimization  

• Run topology optimization  

• Re-analyse the topology optimization results  

• Smooth/redraw the optimized design -maybe using the polyNURB technology  

• Analyse the final design  

  

Note: This exercise is more demanding because you are not only requested to “transfer” the content of the video from below 

right into your Inspire session. It also is quite comprehensive as different load cases are considered.  

  

 

https://altair-2.wistia.com/medias/zeuuqa6ecm  
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11.  Inspire Motion  

 

11.1 Introduction  

 

What is Inspire Motion?  

A concept design tool for understanding mechanism motion, it is an environment for understanding the dynamic motion of 

existing CAD designs and is a tool that will provide dynamic motion loads for a structural analysis or a topology optimization.  

  

What is Motion Analysis?  

A motion analysis will show you how a mechanism will behave with forces, joints, and contacts applied. In Inspire we can 

link components of a mechanism together using various types of joints and contacts to simulate the real-world connections 

in an assembly. The motion is defined in the appropriate degrees of freedom (the direction in which the motion can occur) for 

each connection point. Some type of force can be applied to the mechanism through the use of gravity, a motor, actuator, or 

a spring to replicate the forces applied in the real assembly. By setting up the model and running the analysis, you can 

review the plots on the mechanism. These plots can show results for items such as the torque required for the motor to turn 

the mechanism at various points through the motion.  

 

What are the steps to setup a motion analysis?  

To setup a motion analysis you need to follow 3 steps. The first one is to import the models of the assembly. Next the 

connections need to be created on the assembly. The connections consist of grounded parts, rigid groups, joints and 

contacts. Grounded parts are set for those parts that do not move. The rigid groups are created for those parts that should 

be rigid and linked together. The joints are setup to connect the parts so they move correctly through the range of motion. 

Then the assembly needs to have a force applied to it. The force can be added through gravity, a motor, or an actuator. 

Finally, we run the motion analysis.   

 

What is Inspire Motion Ribbon?  

Inspire motion ribbon includes the tools that are used to set up and run a motion analysis, they allow you to set designs into 

motion using motors, actuators, springs, and other tools. The function automatically assigns motion-generated forces as 

boundary condition inputs for structural FEA or topology optimization. It runs on the MotionSolve solver engine.  
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11.2 Steps to Motion Analysis  

  

Step 1: Import the Model  

So, let’s look at each step of the motion analysis in a little more detail. The first step is to import the models of the assembly. 

Inspire can bring models from many popular CAD packages. Files can be dragged and dropped into the Graphics Window. 

Once open there are many tools to work with the geometry built into Inspire.  

  

Step 2: Create the Connections   

Once the geometry is imported and any editing is complete, the model needs to be connected. Connections come in many 

different forms for setting up the analysis. Pieces of the model are made into the Ground which does not move. Joints are 

placed in the holes where the components of the model meet each other. The joints will be where the models move after the 

setup is complete.  

The functions in the Ribbon required to do this are:  

   

  

  

  

 

Ground parts are the parts which are fixed to the background, 

preventing motion. Most models generally require at least one 

ground part. 

  

  

  

 

They are used to simplify the number of parts requiring joints. When 

defining joints, features between components in a rigid group (holes, 

planar surfaces) will not be detected. 

  

   

 

Joints connect parts or rigid groups to other parts or rigid groups 

through specific features or locations to limit the relative motion 

between them. 
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Step 3: Create the Motion Forces  

Forces are applied to the model in one of many forms to move the mechanism. The force can come from gravity or from 

motor or actuator. The motor can be configured with various specifications to drive the mechanism. The actuator has 

properties that apply to provide the force to drive the mechanism.  

The functions in the Ribbon required to do this are:  

 

         

  

 

Motors allow models to be driven with time-dependent rotational 

motion or loading. 

   

           

  

 

Actuators allow models to be driven with time-dependent 

translational motion or loading. 

       

           

  

 

Springs and Dampers in Inspire apply spring-damper forces between 

two parts. 

     

         

 

Gravity tool is used to apply Gravitational acceleration and adjust its 

direction. It is applied to the entire model and is saved in the model 

file. 

      

           

 

Motion Contacts create 3D contacts between parts or sets of parts 

representing persistent or intermittent contact behaviour and 

including friction effects. 
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Step 4: Run the Motion Analysis  

We then run a motion analysis, plot the results, and extract the results for use in structural (FE) analysis and optimization.  

The functions in the Ribbon required to do this are:  

  

  

  

 

To perform a motion analysis using the default settings 

  

   

 

It helps to extract loads from motion analysis for use in structural FE 

analysis. 

 

  

  

  

 

It is used to extract loads from motion analysis for use in structural 

optimization of a design space. 
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11.3 Exercise: Cam Follower   

This exercise covers the basic features of Inspire Motion, such as navigating the interface, adding joints, grounding parts, 

creating tracers, and cutting geometry based upon results.   

The example we will use in this training exercise is a cam follower which is connected through push rods. The objective is to 

simulate rotation of the disc from which the cam will be designed while proscribing a motion of the follower by actuating the 

push rods.  

Model File:   

https://altairuniversity.com/wp-content/uploads/2018/03/Cam-Follower.zip   

 

  

Step 1: Import the Assembly   

• Start Altair Inspire   

• When Inspire has loaded, select File > Import.   

• Change the filetype selector to Parasolid.  
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Step 2: Sort the push rods into a new subassembly   

• Right-click on the top assembly within the Model Browser and select New Assembly.   

Tip: A new assembly is created in the model and the name area is highlighted immediately, allowing users to enter a new 

name for the assembly.   

• Name the new assembly Push Rods.   

• In the Graphics Area, rotate the model so that the push rods are clearly visible.   

• Tip: By default, the mouse controls are set to Inspire Standard mouse controls. Right-click while dragging to 

rotate the model in 3-axis space. Hold Shift while right-mouse-dragging to pan the model. Use the mouse scroll 

wheel to zoom the model.   

• In the Graphics Area, select the four push rods and magnetic lifters as shown.  

  

 

Tip: Using Inspire Standard mouse controls, left click dragging creates a selection window which will select parts currently 

visible. If another selection window is created or if the user clicks in the graphics area, any currently selected items will be 

deselected. Holding Shift while left click dragging will remove any selections in the created window to the current selections. 

Holding Ctrl while left click dragging will add any selections in the created window to the current selections.   

• Add the Lifting Rod Connector parts and Connecting Rod beneath the four push rods to the selected parts list.  
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• In the Model Browser, drag the list of selected parts into the Push Rods subassembly folder.  

 

 

  

Step 3: Import the link connector assembly   

• Use the Import command to import the Parasolid file Link_Connector_Assembly.x_b.  
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• Review the Model Browser to find the new parts: Link Rod, Link, and Link.   

  

Step 4: Hide the Connector Link Assembly   

• Select the Link Rod, the part shown below by clicking on it.  

 

Tip: When the part is selected in the graphics area, the corresponding part listing in the Model Browser is highlighted and 

selected.  
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• Hold the Control key and click the two Link parts on either end of the Link Rod as shown to add them to the 

selection.  

 

• Press the H key on the keyboard to hide the selected parts.   

  

 

  

Tip: Right-clicking on the selected parts in the graphics area or on the selected list in the Model Browser and selecting Hide 

Selected from the context menu will also hide the parts.   

• Press the R key on the keyboard to reverse the view status of all parts.  Tip: The reverse display function 

toggles all parts view status between displayed and un-displayed. Parts that are displayed will be hidden, and 

parts that are hidden will be displayed.  
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Tip: Right-clicking on the selected parts in the graphics area or on the selected list in the Model Browser and selecting Hide 

Selected from the context menu will also hide the parts.   

• Press the R key once again to bring the model parts including the push rods back to the display and press H to 

unhide the Link Rod and two Link parts.   

 Tip: Note that the parts selected in the display are still selected after using keyboard shortcuts to reverse display the model.   

• Click on any blank area within in the Model Browser to deselect the selected parts.  Tip: Alternatively, to hide 

all parts within a subassembly, users can click on the visibility icon for that subassembly.   

  

Step 5: Set the material for the model to Steel AISI 1080   

• Right click on the parent assembly for the model in the Model Browser.  Tip: A context-sensitive menu will 

appear. The available selections will change based upon the parts or browser entities selected and their 

current state.   

• Mouse over Material to enable the submenu fly-out.  

• Select Steel AISI 1080 from the list as shown. 

  

 

Tip: This will set all of the parts underneath the selected assembly to that material property. The weight of parts will be 

updated accordingly.  
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Step 6: Ground Parts   

• Click on the Motion menu section of the menu bar.   

Tip: Note that the icons of the ribbon change to reflect the motion tools available in Inspire. The ribbon’s icons are ordered 

such that model setup for a particular workflow will generally progress from the leftmost icons to the rightmost.   

• Click the Ground icon   to enter the Ground Parts tool.   3. In the graphics area, select the four T Guide 

parts and the Pin.  

 

  

• Review the Model Browser to confirm that the selected parts have been grounded.  

 

Tip: The icon for the part will change to illustrate that the part is considered connected to Ground.   

• Press Esc on the keyboard or right-click the mouse in the graphics area to exit the Ground tool.  
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Step 7: Create rigid groups within the model   

• Right-click on the Push Rods subassembly and select the menu option Create Rigid Group.   

• Repeat the process for the Link Connector Assembly subassembly to create a rigid group from that 

subassembly.   

• Turn on visibility of the Link Connector Assembly subassembly in the graphics area.  

• Click the Rigid Groups icon   to enter the tool to create the final rigid group for this model.  

• In the graphics area, select the Lifting Lever and the Follower as shown  

 

New Group button appears. 

 

• Click Create New Group to create the final rigid group in this model and click Esc or right-click in the graphics 

area to exit the Rigid Groups tool.  

 

  

• Click on the Rigid Groups satellite icon to show the Rigid Groups Table, which illustrates that there are three 

rigid groups within the model.  
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• Close the Rigid Groups Table window.  

  

Step 8: Create joints within the model   

• Click on the Joints icon  to open the Joints tool.   

 

Tip: By default, inspire searches the model for features which indicate the presence of a joint connection. Detected features 

are illustrated throughout the model in red.  

 

• Within the guidebar of the Joints function, change the features searched selection from All to Cylindrical Pairs 

using the drop-down chevron.  
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• Click on the hamburger menu button at the beginning of the guidebar and select Options to display the Joint 

Options dialog.  

• Uncheck Auto search distance and enter 0.003 meters in the search distance field.  

  

• Click outside the box to close the options dialog.   

• On the guidebar, change the joint type from Auto to Cylindrical using the dropdown chevron.  
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• Box select the four T Guide highlighted pairs to create cylindrical joints there as shown:  

 

• Change the joint type from Cylindrical to Hinge and select the bottom four highlighted pairs to create hinge 

joints there.  

 

• Exit the Joints tool.   
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Step 9: Add a motor to the model   

• Click on the Motors icon   to open the Motors tool.   

• Rotate the model so that the X+ side of the disc is visible and hover the mouse over the center of the disc hub 

to have the snapping function locate the center of the hub face as shown below.  

 

• Click while the Cen tooltip is visible to select the center of the hub as the motor shaft connection point.  

 

• Click on the red face of the hub to align the shaft of the motor normal to that face and create the motor, placing 

the motor base close to the hub face.  
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Tip: By default, all motors are created as angular speed motors with an activated controller in Inspire – the ωc illustrates the 

controller is currently turned on. If the controller is deactivated, the notation will change to simply ω.   

• In the microdialog, click the first drop-down to set the motor type to angle (θ) and set the total angle to 360 

degrees.  

 

  

• Change the function  type from Step using the drop-down for that option.  

• Click the chevron at the end of the microdialog to show the advanced options for the motor.  

 

  

• Click the Use Controller  to toggle the controller off icon  

• In the Property Editor, turn on the Restrain Centerline option under General options and set the duration for the 

function to 1 second under the Profile section.  

  

 to Ramp  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  307   

 

                            

• Exit the Motors tool.  

  

Step 10: Add an actuator to the model   

• Click on the Actuators icon  to open the Actuators tool.   

• On the guidebar, set the feature search type to Features.   

• Orient the model to view the bottom face of the Lifting Lever.   

• Locate and click on the midpoint of the rear edge of the Lifting Lever as shown.  
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• Click on the red face to connect an actuator at the selected midpoint and normal to the face.  

  

 

• In the microdialog, enter a displacement of 0.06 meters.  

• Use the chevron to display advanced options for the actuator.   

• Disable the controller and set the Start time to 0.1 seconds.  

 

• In the Property Editor for this actuator, set the Step-On Duration to 0.2 s, the Dwell Time to 0.4 s, and the Step 

Off Duration to 0.2 s.  
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• Exit the Actuators tool.   

  

Step 11: Set analysis settings and run the model   

• Click on the Analyze Motion satellite icon   to open the Analyze Motion tools Run Motion Analysis 

dialog.   

  

 

• Set the End time to 1 s.   

• Set the Output rate to 100.   

• Click Run to run the simulation.  
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Step 12: Update visualization for easier visualization of the post-processing   

• Click on the Disc in the graphics area or within the Model Browser to load its properties into the Property 

Editor.   

• Under Appearance, set the Transparency to 50%.   

• Tip: The Disc in the graphics area is now semi-transparent.   

• Play back the animation once more, verifying that parts can be seen animating through the Disc.   

  

Step 13: Create a trace curve  

• Click the Tracers icon   to enter the Tracers tool.  

• Click on the end point of the point of the Follower closest to the Lifting Lever as shown below to create the 

trace point:  
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Tip: The trace point shows up as an orange dot on the model and Tracer 1 is highlighted in the Model Browser.   

• Hold down the Ctrl key and click on the Disc to discover the trace path relative to the motion of the Disc.  

 

     

Tip: When setting a relative trace it is important to do the Ctrl-click operation immediately after selecting a trace point, with 

no clicks in-between. If the disc does not highlight in red with the trace path projected against it, consider deleting the 

original trace point and trying again.   

  

 

Step 14: Use the trace curve to cut the disc into a cam   

• Exit and re-enter the Tracers tool, ensuring that the trace curve is displayed on the screen.   

• Right-click on the trace curve and select Create Spline from the context-sensitive menu.  
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Tip: This creates a new spline body with zero mass in the main assembly.  

  

 

• Click P on the keyboard to activate the Geometry menu Push/Pull tool.   

• Pull the spline curve of the tracer completely through the Disc and out of the other side.  

 

• Right click to exit the Push/Pull tool.  

• In the Geometry menu, enter the Boolean tool  

 

• Click Subtract Parts   

• Using the Boolean Subtract guidebar workflow, ensure that Targets is highlighted and select the Disc.  
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• Click on Tools to activate it in the guidebar workflow and select the spline surface created by pulling the tracer 

curve.   

• Click Subtract in the guidebar, cutting the Disc into two bodies using the tracer curve surface.   

• Exit the Boolean tool.   

• Right-click on the Disc in the graphics area and select Convert Bodies to Parts in the context-sensitive menu.  

 

Tip: Review the Model Browser to find the new part created from the Disc Boolean process.   

• Delete the part outside of the desired cam.  
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Step 15: Rerun the motion analysis to verify that the follower tip aligns with the cam geometry  

 

 

  

  

   

11.4 Detailed Information about the Various Entities  

 

 Ground Tool  

In Inspire, parts are considered moving by default. Ground parts are the parts which are fixed to the background, preventing 

motion. Most models generally require at least one ground part.  

  

To create a ground part:  

• Select the Ground tool  

• Click on a part in the graphics area to set it as grounded   

Any visible grounded tools will display in the graphics area as red while the Ground tool is active.  

  

Rigids Group  

They are used to simplify the number of parts requiring joints. When defining joints, features between components in a rigid 

group (holes, planar surfaces) will not be detected.   
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To create rigid groups:  

• Select the Rigid Groups tool  

• Click on parts to group in the graphics area to set it as grounded  

The upper right-hand corner of the Rigid Groups icon will show the number of rigid groups in the model. Any visible 

grounded parts will display transparent in the graphics area while the Rigid Groups tool is active. The Rigid Groups table 

can be displayed by selecting the satellite icon next to the Rigid Groups icon. The Rigid Groups table can be used to toggle 

the visibility of groups in the model by clicking on the icon.  

 When using Rigid Groups:  

• This tool can only be used to create a Rigid Group of parts, not fasteners or joints.  

• To ungroup a Rigid Group, select the group using the arrow keys on the guide bar and click on the Ungroup 

button.  

• If a Rigid Group contains one ground part, the entire rigid group is considered ground.  

• Joints, Springs, or other connections between parts within a Rigid Group are ignored.  

• You can also define a Rigid Group by right-clicking on an assembly or part from the Model Browser and 

choosing Create Rigid Group from the context menu  

• Placing all parts for a Rigid Group into a subassembly prior to grouping saves time on the grouping operation 

and simplifies finding all the parts associated with that specific group.  

 

Joints Types and States 

Every joint has a type, such as pin or hinge, and state, which can be set to locked, active, or free. Double-click a joint to 

open a micro dialog and edit the type or state.  

 

  

Joint Types  

Joints are available in a variety of types such as Pin, Hinge, or Ball and Socket. The types available vary based on the 

feature where the joint is being applied. The Auto Joint Type in the table below is the type of joint that will be created if you 

select Auto on the Joints guide bar. If this option is selected, the tool will automatically determine the best type of joint to 

place at each selected (red) feature location.  

 The Degree of Freedom retained by different joints are:  
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Available Joint Types  Translational DOF  Rotational DOF  

Hinge, Pin, Grounded Pin 0 1 

Cylindrical, Sliding Pin, Grounded 

Sliding Pin 
1 1 

Translational 1 0 

Planar 2 1 

Ball and Socket 0 3 

    

Feature  Auto Joint Type  Available Joint Types  

Aligned holes  Pin  
Pin, Grounded Pin, Sliding Pin, Grounded  

Sliding Pin, Ball and Socket  

Single holes  Grounded Pin  Grounded Pin, Grounded Sliding Pin  

Cylindrical pairs  Cylindrical  
Hinge, Cylindrical, Translational, Ball and  

Socket  

Cylindrical pairs +  Hinge  
Hinge, Cylindrical, Translational, Ball and  

Socket, Planar  

Spherical pairs  Ball and Socket  Ball and Socket  

Planar pairs  Planar  Planar  

Multi-planar pairs  Translational  Translational, Cylindrical  

  

When a joint isn't recognized as any of the above types, it is categorized as an Unknown joint.  

  

Joint States  

Each joint has a state which can be set to Locked, Active, or Free.  

• Select Locked to prevent movement in the joint. This is useful for debugging and what-if scenarios.  
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• Select Active to allow the joint to function automatically.  

• Select Free if you want the mechanism to behave as if the joint is not there.  

By default, all joints are set to Active unless their type is Unknown, in which case they are set to Free. If an Unknown joint is 

set to Active, its type will be automatically redefined as Ball and Socket.  

By default, all Joints created in Inspire are flexible.  

Using the Property Editor, Joints can be set to Rigid instead of the default. Rigid Joints completely prevent any motion 

outside of the specific degrees of freedom allowed by the Joint definition.  

In this way Joints defined as Rigid can cause redundant constraints within a model, so we avoid using Rigid Joints wherever 

possible.  

  

Examples  

Following are examples of detected features shown with the typical best joint type.  

  

1. A pin and sliding pin placed at aligned holes.  

 

 

  

2. A grounded pin and grounded sliding pin placed at single holes.  
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3. A cylindrical joint placed at a cylindrical pair.  

 

  

4. A hinge joint placed at a cylindrical pair plus.  

 

5. A planar joint placed at a planar pair.  
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6. A translational joint placed at a multi-planar pair.  

 

 

 

7. A ball and socket joint placed at a spherical pair.  

 

 

  

 

Joint Friction  

Forces that arise from frictional effects can be included in motion analysis for rigid joints using the Property Editor. You can 

specify the coefficients of friction (static and dynamic) and include other model parameters which allow you to model 

frictional drag and stiction effects.  

When the joint behavior has been set to Rigid in the Property Editor, you can enable friction for the following joint types: Pin, 

Sliding Pin, Hinge, Cylindrical, Ball and Socket, and Translational.  

Inspire Motion uses the LuGre (Lundt-Grenoble) model for friction, and the following properties related to joint friction are 

available in the Property Editor. These are advanced properties and require knowledge of frictional effects to be used 

appropriately.  
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1. Input Forces  

• Specifies the input forces for the friction model.   

• The options available change based on the joint type, and include Preload, Reaction Force, Bending Moment, 

and Torsional Moment.  

  

2. Friction for Motion  

• Enable Friction: Select to enable the other friction-related options in the Property Editor. The Enable Friction 

option itself is only visible when the joint behavior option is set to Rigid  

• Autocalculate Geometry Parameters: This option is enabled by default. Disable it if you want to manually 

enter dimensions for geometry parameters such as the pin radius, friction arm, and bending arm.  

 

3. Friction Effect  

• Effect Type: Specifies the frictional effect. By default, both static and dynamic friction are considered. The 

Stiction Only option uses only static friction, while the Sliding Only option uses only dynamic friction  

• Static Coefficient: Specify the static friction coefficient (µs) in the joint  

• Dynamic Coefficient: Specify the dynamic friction coefficient (µd) in the joint  

• Stiction Transition Velocity: Specify the joint velocity at which the friction effect transitions from dynamic 

friction to static friction  
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• Active for Static Analysis: Disabled by default. Select this option to apply friction effects when running a 

static motion analysis.  

  

4. Controller  

A controller is provided to try and reach a desired (target) value by means of a feedback control loop. Motors and actuators 

use a controller by default but have an option on the microdialog               that allows you to disable the controller.  

 

  

 

 

 

 

There are two types of controllers available from the Property Editor:  

• PID  

• Soft Constraint (available for angle motors and displacement actuators only)  

  

5.  PID Controller  

PID is a conventional Proportional-Integral-Derivative (PID) control scheme. If the controller does not respond the way you 

expect, you can adjust the gains in the  

Property Editor  

• Proportional Gain  

• Integral Gain  

• Derivative Gain 

  

Soft Constraint Controller  

A soft constraint is not a conventional controller, but more like a mathematical constraint with some violation allowed. That is 

why it is a soft constraint, as opposed to a hard constraint which allows no violation.  

You can change the behavior of a soft constraint by adjusting the factors in the  

Property Editor  

• Proportional Factor  

• Derivative Factor  
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Profile Functions 

Before setting up a Motor or an Actuator for analysis you need to have some basic information about the Profile functions 

and the Controllers that are used to set up the motors and actuators.  

Motors and actuators have a profile option on the microdialog that allows you to change how the shaft moves as time 

elapses.   

The following profile functions are available:  

  

• Step  

 

  

  

• Step Dwell Step  
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• Single Wave  

 

  

  

    

• Oscillating  
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• Swept Sine 
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• Impulse 

 

 

  

  

  

    

• Ramp  

 

  

  

 

 

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  326   

 

• Solver Expression 

 

    

• Table  

 

  

 

Converting a Profile Function to a Table  

If you convert the profile to a table, the data points are converted to a table that can be modified and saved as a .csv file.  

Click Spline or Derivative in the legend to plot one or the other.  
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Icon  Description  

   

Load values from a .csv file. Alternatively, you can simply drag and drop a valid 

.csv file onto the profile editor. 

 

  

Save data to a .csv file 

  
Insert a value before the first data point. 

    

Insert a value after the selected data point. 

  

Insert a value after the last data point. 

  
Delete the selected data points. 
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Motors  

  

 

 

 

 

 

 

 

Motors allow models to be driven with time-dependent rotational motion or loading. Creating motors in Inspire requires two 

clicks: placing a shaft and placing a base (or mount).  

The motor shaft can be defined using a hole, surface, or pin:  

• When defining a motor using a pin, the motor replaces the pin  

• In this case, the motor shaft is oriented to the pin axis The base can be defined using a hole or surface:  

• When selecting the same feature as the first click, the motor will mount to (and react against) Ground.  

  

The motor appears and the micro dialog for the motor becomes active.  

Motor graphic is scaled according to area of the first selected feature. Graphic can be manually scaled by changing the 

shaft radius in the Property Editor.  

  

1. Creating a Motor  

2. Select the Motors tool.  

3. Select a hole, surface, or pin.  

• For pins, click once to replace the pin with a motor.  

• For holes and surfaces, click once to position the shaft, and a second time to position the base. (You can 

select the same hole or surface twice; in which case the second click is interpreted as reacting against 

ground.)    

4. Optional: Use the ω, θ, α, T drop-down menu on the micro dialog to change the type of motor. Options are speed, 

angle, acceleration, and torque.  

5. Optional: Use the +/- button to reverse the motor's direction of rotation.  

6. Enter a magnitude in the text field for the rotation speed, angle, acceleration, or torque. Think of this as a target 

speed or angle when using the default controller.  

7. Right-click to exit the tool.  
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Microdialog Options  

 

 

  

• Type: Use the ω, θ, α, T drop-down menu on the microdialog to change the type of motor. Options are speed, 

angle, acceleration, and torque.  

• The different types of motors available in Inspire Motion are:  

• Angular Displacement  

• Speed (Default)  

• Acceleration  

• Torque  

 

 

 

 

 

  

• Reverse Direction: Use the +/- button to reverse the motor's direction of rotation.  

• Set Speed/Angle/Acceleration/Torque: Enter a magnitude in the text field for the rotation speed, angle, 

acceleration, or torque. Think of this as a target speed or angle when using the default controller.  

•  

• Lock the Motor: Lock the motor to prevent it from rotating. This is useful for debugging.  

• Profile Function: Use the profile function to change how the shaft rotates as time elapses. Examples include 

step, single wave, or oscillating.  
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•  Profile Editor: Icon on the motors or actuators microdialog to open the Profile Editor to view the profile 

function.   

•  Use Controller: A controller is used to achieve the target speed or angle. If you disable the controller it 

will use the target profile directly, which could result in excessive deformations or other warnings.  

• Base Shape: Use the Base Shape option to change the appearance of the motor. Use the Shaft Radius 

property in the Property Editor to adjust the overall size. (This property is not available for motors applied to 

holes.)  

•  Move Motor: Click to open the Move tool, allowing you to reposition the motor.  

•  Align Normal to Face: Click to align the motor so it is perpendicular to the face to which it was applied.  

•   Start: Enter a start time for the motor. This allows you to start individual motors and actuators at 

different times for the motion analysis.  

•  Display options for Servo, Front-Facing, Rear-Facing, and Mounted Motors (visual only)  

  

  

Motors Tips & Tricks  

•  An option to hide all motors is available in the right-click context menu. In some models hiding all motors may 

improve performance of the animation.  

• Motors cannot be created on pins that connect more than two parts.  

• When using the Restrain Centerline option for motors available through the Property Editor, implicit joints are 

created to enable the constraint. These joints generate results when analyzed and can be plotted.  

 

•   Motors can be locked to prevent rotation by using the Lock button in the microdialog. This can be 

useful when debugging a model.   

 

•   Motors can also be ‘locked’ by entering a zero in the entry field for speed. To enter a nonzero 

value, click the Lock button.  

• When creating motors in a sequence, new motors inherit parameters from the immediately previous motor 

setup created  

• When hovering over a motor, a tooltip is displayed showing information about the motor definition.  

  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  331   

 

 

 

 

Actuators  

                                         

Actuators allow models to be driven with time-dependent translational motion or loading.  

The Actuators guide bar offers two methods for creating actuators:  

1. Connected Parts actuator creation offers convenience  

2. Features-based actuator creation offers flexibility.  

 

Inspire scans the model for appropriate parts and/or joints before suggesting actuator creation locations, so it is best to 

create all model joints prior to creating actuators  

1. Create Feature-based Actuators:  

• Creating Features-based actuators in Inspire requires two clicks: placing a shaft and placing a base (or mount)  

• The actuator shaft can be defined using a hole, surface, or pin. When defining an actuator using a pin, the 

actuator replaces the pin. In this case, the actuator shaft is oriented to the pin axis  

• The base can be defined using a hole or surface. When selecting the same feature as the first click, the 

actuator will mount to (and react against) Ground.  

2. Create Actuators using Connected Parts search  

• Creating actuators in Inspire using the Connected Parts option requires a single click: click anywhere on a 

detected red pair to create an actuator.  

  

 Microdialog options  

 

 

 

 

 

• Type: Use the D, V, A, F drop-down menu on the microdialog to change the type of actuator. Options are 

displacement, velocity, acceleration, and force.  

The different types of Actuators available in Inspire are:  
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• Displacement  

• Velocity  

• Acceleration  

• Force  

  

• Reverse Direction: Use the +/- button to reverse the actuator's direction of translation, as indicated by the 

arrow.  

• Set Displacement/Velocity/Acceleration: Enter a magnitude for the displacement, velocity, acceleration, or 

force. Click the icon to calculate the default displacement.  

• Lock the Actuator: Lock the actuator to stop it from translating. This is useful for debugging.  

• Profile Function: Use the profile function to change how the shaft translates as time elapses. Examples 

include step, single wave, or oscillating.  

 

 

• Use Controller: A controller is used to achieve the target displacement or velocity. If you disable the controller 

it will use the target profile directly, which could result in excessive deformations or other warnings.  

• Move Actuator: Click to open the Move tool, allowing you to reposition the actuator.  

• Align shaft with connection: Click to align the actuator so it is perpendicular to the connection to which it was 

applied.  

• Start: Enter a start time for the actuator. This allows you to start individual motors and actuators at different 

times for the motion analysis.  

  

Springs  

 

  

 

  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  333   

 

 

Springs and Dampers in Inspire apply spring-damper forces between two parts:  

• Coil springs provide translational force and damping  

• Torsion springs provide rotational force and damping  

  

Spring/Dampers can be created in the following combinations:  

• Spring Damper  

 

• Spring only  

 

•  Damper only  

       

 

 

To define a spring:  

• Select either the coil spring or the torsion spring icon  

• Select a location  

• Select a second location  

• The spring is created and the options microdialog appears  

 

To define a (linear) spring/damper:  

• Select a Part  

• Select a Pin  

• Select Fasteners  
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Springs can be preloaded to provide a specified force at their created position. If a pre-load is specified, red arrow vectors 

appear stemming from the ends of the spring:  

• In compression, the arrows point outward  

• In tension, the arrows point inward.  

 

To define a (rotational) spring/damper:  

• Select hole  

• Select location on a surface  

• Select a pin  

 

 

 

 

 

 

  

  

 

Microdialog Options  

For Coil Springs and Dampers (translational force):  

• Spring stiffness  

• Damping value  

• Preload  

• Free Length  

• Installed Length  

 

• Move Manipulator Tool  

• Spring/Damper Flip Tool  
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For Torsion Springs and Dampers (rotational force):  

• Spring stiffness  

• Damping value  

• Preload  

• Free Length  

• Installed Length  

• Align with Global Axes (X, Y,Z)  

 

• Align Normal to Face  

 

• Move Manipulator Tool  

 

Stretched diameter coil springs have a second microdialog  

• Spring diameter, number of coils, and wire diameter are editable   
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Gravity  

Gravity tool is used to apply Gravitational acceleration and adjust its direction. It is applied to the entire model 

and is saved in the model file. You can turn the gravity on or off using the settings in the Run Motion Analysis 

window.  

  

Applying Gravity  

Enter a gravitational acceleration and define the direction of gravity.  

1. Select the Gravity tool. By default, the gravitational acceleration (G) is set to 9.80665 m/s2 in the -z direction.  

2. Right-click to accept the default value or enter a different magnitude for the gravitational acceleration in the 

microdialog.  

3. Click the  icon to restore the default value of earth gravity.  

4. Optional: Click the +/- icon to reverse the direction of gravity (G).  

5. Optional: Use the options on the microdialog to change the alignment of gravity (G), using one of the following 

methods:  

• Select either direction gravity mode   or component gravity mode   , then click the   to define a 

direction or component vectors.  

• Use the X, Y, Z buttons to align gravity to the negative X, Y, or Z direction. Click a second time to align in the 

positive direction.  

• Use the Move tool on the microdialog.  

6. Right-click to exit the tool.  

  

 

Microdialog Option  

 

 

  

• Reverse Direction of the Magnitude: Reverse the direction of gravity (G).  

• Set Magnitude: Enter a magnitude for the gravitational acceleration. Click the icon to restore the default 

value of earth gravity.  

• Direction Gravity Mode/Component Gravity Mode: Use to change how gravity is defined. You can enter a 

magnitude and a direction vector (X, Y, Z), or you can enter the gravity by its vector components (Gx, Gy, Gz). 

Click the  to define the direction or component vectors.  
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• Rotate: Rotate the direction of gravity (G) using the Move tool.  

• Align to X, Y, Z Global Axis: Align gravity to the negative X, Y, or Z direction. Click a second time to align in 

the positive direction.  

• Set X, Y, Z Axis Component: Click the to define the direction of gravity by entering direction vectors for 

X, Y, and Z. (For example, entering 1, 0, 0 would orient it in the positive x direction.)  

• Set Gx, Gy, Gz Component: Click the  to define the direction of gravity by entering gravity component 

vectors for Gx, Gy, and Gz. (For example, entering 0, 0, - 9.81 would orient it in the negative z direction.)  

   

Motion Contact  

Motion Contacts create 3D contacts between parts or sets of parts representing persistent or intermittent contact behavior 

and including friction effects.   

Convenient options like By Material, By Rigid Group, and At Free Joints are helpful for creating contact pairs with minimal 

effort in a variety of applications.  

  

Creating Motion Contact  

To create motion contact:  

1. Select the Contacts tool on the Motion ribbon  

2. Select what method to use to place parts into sets using the guide bar  

3. Click Parts1 and select the part to the first set, click Parts2 and select parts to place in the second set  

4. Click Create on the guide bar  

 

 

 

The Contacts selection methods available include:  
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• By Parts: Select parts one by one to add to them to a set.  

• By Connection: Parts connected together are selected.  

• By Material: Parts that have been assigned the same material are selected.  

• By Assembly: Parts that belong to the same assembly are selected.  

• By Rigid Group: Parts that belong to the same rigid group are selected.  

• At Free Joints: Part pairs associated with free joints are selected. Use the navigation arrows on the guide bar 

to jump from one-part pair to the next. When using this method, both sets (Parts1 and Parts2) are populated 

for you.  

    

 

 

 

 

 

 

 

 

 

The Contacts panel:  

  

 

 

Contacts Options  

Apply global options before creating motion contacts.  

• Enable Friction: Include forces that arise from frictional effects.  

• Click the chevrons to expand the view and edit additional options.  
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• Static coefficient: The static coefficient of friction  

• Dynamic coefficient: The dynamic coefficient of friction  

• Stiction transition velocity and Friction transition velocity: The transition velocities controls the sharpness of 

transition between the friction coefficients (static and dynamic).   

• Collision Type: Select a collision type – Impact (default), Poisson, or Volume.  

• Exclude Design Spaces: Enable this option to prevent design spaces from being selectable  

• Exclude Ground: Enable this option to prevent ground parts from being selectable  

                                  

There are three contact types available in Inspire Motion  

 

Impact (Default)  

 

• Stiffness: The stiffness of the boundary surface interaction  

• Damping: The maximum damping coefficient  

• Penetration depth: The depth beyond which full damping is applied  

• Exponent: The exponent on penetration depth  

  

  

Poisson  
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• Penalty: Local stiffness properties between materials. Larger values reduce penetration   

• Coefficient of restitution: Energy loss between the two parts in contact.   

• Range of 0.0 and 1.0.  Where 1.0 represents a perfectly elastic contact and  

• 0.0 represents a perfectly plastic contact  

• Normal velocity: Velocity limit after which full damping force is applied  

 

  Volume  

 

 

 

 

• Damping: Damping coefficient value used to calculate the damping force 

• Exponent: The exponent of the force deformation characteristic   

• Material layer depth: The layer depth of material used to calculate the contact stiffness  

  

Contacts Properties  

Contacts properties can be edited through the Property Editor or Motion Contacts table:  

• Collision Type  

• Contact properties  

• Enable Friction – On/Off  

• Friction properties  

 

• Advanced settings  

o Precise Contact Event: If you enable this property and enter a Tolerance, the solver will more 

precisely determine when two parts come into contact. This option improves the accuracy and 

robustness of motion contact simulations, but also increase simulation time, so it should be used only 

when necessary.  

o Refine Step Size: If you enable this property and enter a New step size, the solver will use it as the 

maximum step size for the simulation after the contact is detected.  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  341   

 

o Contacts can be turned On/Off in the model using the Contacts option in the Run Motion Analysis 

window  

  

 

 

Run Toolbar  

The tools in the Run group on the Motion ribbon are used to run a motion analysis, plot the results, and extract the results for 

use in structural (FE) analysis and optimization.  

 

Analyze Motion  

 

 

The tools on the Analyze icon are used to run, view and plot the results, and change settings for a motion analysis.  

Analysing a model in Inspire is as simple as clicking the Quick Run section of the Analyse Motion icon. For a more detailed 

or specific analysis, the satellite icon can be used to enter the Run Motion Analysis dialog.  

  

Quick Run  

In the Run Motion Analysis dialog:  

• End time: Choose from pre-defined run times and sampling rates  

• Output rate: Controls the resolution of the animation, the number of data points making up plots, and the 

number of output steps available for exporting motion loads to a structures analysis or topology optimization  

• Animate: Allow to animate while solving each time step (slower) or animate after the math solution is 

completed (faster)  
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• Analysis Type: Solve static, transient, or static + transient analysis  

• Gravity: Toggle gravity on/Off  

• Advanced: Access advanced simulation settings.  

 

  

Reviewing Motion Results  

 

  

There are three options available for viewing animation results:  

• Select play button on animation playback tool  

• Drag the slider on animation playback tool  

• When the slider has focus, use the arrow keys on the keyboard to move frame-by-frame through the animation  

  

The animation playback tool provides several features when animating results:  

• Click Play to animate results    OR   Drag slider to animate  

• Enter a time to jump to the animation at that time  

• Additional animation settings are available  

• Model position can be saved & used as starting point for subsequent simulations  

 

  

Model animation type and speed can be set using additional animation settings:  

• Loop playback  

• Bounce playback   
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• Once  

 

 

 

 

 

 

Plotting Motion Results  

When simulation results are available, there are two ways to plot results:  

• Mouse click on a part or feature in the graphics area  

• Click on a feature name in the browser  

OR 

• Right-mouse click on a displayed plot to access other plot types  

• Several types of plot results can be exported to *.csv files  

• Click blank space in the Graphics Area to dismiss the current plot  
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To manipulate a plot in Inspire:  

 

To  Do this  

Choose what can be 

plotted/exported 
Right-click on the chart. 

Cycle through plots 
Use the up/down arrow keys to move through the entities in 

the Model Browser. 

Increase the plot size Press Ctrl + 

Decrease the plot size Press Ctrl - 

Reset the plot size Press Ctrl 0 (zero) 

Exit the tool Press Esc or RMB 

  

 

Exporting Motion Results  

You can now Export motion analysis results using the Export button on the Run Motion Analysis window. You can also 

export plots and other data in CSV format by selecting a plot.  

  

Analyze Part  

 

  

Motion Loads can be used as boundary condition inputs to an Inspire Structures analysis or Topology Optimization. It helps 

to extract loads from motion analysis for use in structural FE analysis.   

• Inspire Motion automatically assigns the load value and direction at each connection point  

• Individual parts can be analyzed for frequency, stress, displacement, etc. using the Analyze Part tool  

• Parts and package spaces can be optimized using topology, topography, gauge, or lattice optimization using 

the Optimize Part tool.  
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Loads from Motion 

When you analyses a part using a motion run, the part is loaded from the results of the motion simulation. You can choose 

to select which points in time are analyzed by extracting the peak loads, evenly spaced time samples, all time samples, or 

range of times.  

 

 

• Use # peak loads per connection: This option will extract time samples where peak loads occurred during 

the previously run motion analysis. This is the default option.  

• Use # evenly spaced samples: This option will extract evenly spaced time samples from the previously run 

motion analysis. This is useful for seeing how stresses develop as the part is moved.  

• Use all # time samples: This option will extract loads from all time samples from the previously run motion 

analysis.  

• Time range # to #: Select the checkbox to define a time window to limit the number of samples. This can be 

applied to any of the three options above.  

  

Optimize Part  

It is used to extract loads from motion analysis for use in structural optimization of a design space. Because optimization is 

an iterative process, only use what motion loads are necessary as an input to optimization.  
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To increase the speed of the optimization run, consider:  

• Using a reduced number of peak loads  

• Using evenly spaced samples to generate the input loading  

• Limiting the simulated time used to generate the optimized part.  

  

 

  

When optimizing design-space parts to other parts:  

• Design spaces should be partitioned with a non-design space at the connection of that part to any joint, motor, 

actuator, spring, etc.  

• Place the design space and the partitions into a rigid group  

If the part is already in a rigid group, then partitions created from that part will automatically be members of the same rigid 

group.  

  

Tracers  

Tracers allow path history tracing of points within a model. The traced path is dependent upon completed motion analysis 

results After a path is drawn, it can be used for geometry creation and modification. You can synthesize shapes (like cams) 

from the part's motion by choosing to draw the path on a moving reference frame.  
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To create a tracer in a model:  

• Select the Tracers tool  

• Select a trace point. This acts as the “pen” which draws the trace.  

• If there are no results yet, run a motion analysis  

• If there are results, the trace path will appear  

  

To get a full trace path for the last valid motion run:  

• Enter the Tracers tool   

              OR  

• Use the Review Motion Results tool  

• View the last step in the animation  

 

  

    

11.5 Exercise: Excavator   

This exercise reinforces the basic features of Inspire Motion, such as navigating the interface, adding joints, adding 

actuators, plotting results, and analysing for stress and deflection using dynamic motion loads. The exercise is meant to be 

performed after performing Exercise 1a, as explicit step-by-step instructions are not necessarily given here and users should 

operate through their knowledge of the Inspire environment.  The example we will use in this training exercise is an 

excavator model. The objective is to complete the model’s setup including CAD import, grounding and jointing, actuation for 

specific motion, tracing, and stress analysis.  

  

Model File: https://altairuniversity.com/wp-content/uploads/2018/03/Excavator.zip   
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Step 1:  

Import the model Excavator.x_b from a Parasolid file   

 

Step 2:  

Rotate the model so that Z+ axis is ‘up’   

• Select the top assembly within the Model Browser to select the entire model.   

• Click M on the keyboard to activate the Move tool.   

• Orient the mouse over the X-axis rotate control as shown and click to bring up the microdialog.  
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• Enter 90 deg in the microdialog field and click Enter to perform the model rotation.   

• Right-click to exit the Move tool and click in the graphics area to deselect the model.   

 

Tip: Model rotation within Inspire is set to preferentially bias rotation around the Zaxis to enable rotation of a model about 

that axis. Rotation of the model so that the Z-axis is ‘up’ makes many following operations when reorienting the model more 

intuitive.  
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Step 3: 

Change the color of the entire model   

• Again, select the top assembly within the Model Browser.   

• In the Profile Editor, select the Value area of field Color to bring up a color chart.   

• Select a new color and deselect the model.  

 

 

 

 

 

 

 

 

 

Step 4:  

Change the color of the tracks and cab windows and cab door to a dark grey  
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S 

 

 

 

 

 

 

Step 11: Select the created joints within the Model Browser and change their type in the microdialog to Cylindrical  

  

 

  

Step 12: Exit the Joints tool and press A to show all components   

Step 13: Re-enter the Joints tool to scan the model for any remaining joints which need to be created  
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Tip: There should be 14 joints which remain which need to be connected as illustrated on the Joints icon following the 

search through the model   

Step 14: In the Joints tool guide bar, use the Connect All feature to connect the 14 outstanding joints with default joint types   

Step 15: While in the Joints tool, select the two cylindrical joints created at the end of the joints list in the Model Browser and 

set their type to Hinge  

  

 

Tip: For a more in-depth look at the differences between a cylindrical and hinge joint, refer to the Altair Inspire Help under 

Joint Types   

Step 16: Click on the Gravity tool to verify the direction of the gravity vector lines up with the “down” direction in the model  

 

  

Step 17: Use the Quick Run feature of the Analyse Motion tool to run a quick analysis to verify that the ground parts, rigid 

groups, and joints are set up correctly  
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Tip: Since the excavator arms are not constrained in any way other than their joint connections, the mass and location of the 

booms and bucket acts as a pendulum connected by pin links   

Step 18: Add a motor to control the main cab rotation   

• Hide the Suspension subassembly and rotate the model to view the bottom of the cab.   

• Enter the Motors tool.   

• Select the center snap point of the base circle on the cab as shown to set the location of the shaft center and 

click the circle again to set the base.  
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Tip: Note that the motor base graphic is scaled according to the feature size of the connecting part.   

• Using the microdialog, set the motor type to Angle  and set the profile to Table  .   

• Click the Edit the Table Profile button to enter the Profile Editor.   

• In the Profile Editor, click the Load Data icon  . Navigate to and load the file Turret_Motor-Travel_Plot.csv.  
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Tip: The file is read and populated into the Profile Editor for review and editing.   

• Close the Profile Editor.   

• Using the advanced options in the motor microdialog, deactivate the motor controller.   

  

Step 19: Add actuators to the model   

• Enter the Actuators tool on the Motion ribbon.   

• Ensure that the guidebar search mode is set to Connected Parts.  

 

  

Tip: Four connected part pairs are found – the four cylindrical joints that form the Bucket, Boom RH, Boom LH, and Ext 

Boom actuators.   

• Click Create All on the guidebar to create actuators in these locations with the default settings.   

• Select all of the actuators in the Model Browser and click the Reverse Direction option in the Property Editor to 

flip the direction of all of the actuators at the same time.   

• While all four actuators are selected, uncheck the option for Use Controller in the Property Editor.   

• Tip: We will be using *.csv files to provide exact motions for the actuators in this model.   

• Select the first actuator in the model and review its connected parts under the Applied To section in the 

Property Editor. One at a time, rename the actuators in the model according to their connected parts as 

follows:  
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Connected Parts   New Name   

Bucket Cylinder, Bucket Piston   Bucket   

Boom Cylinder LH, Boom Piston LH   Boom   

Boom Cylinder RH, Boom Piston RH   Boom   

Ext Boom Cylinder, Ext Boom Piston   Ext Boom   

  

 

Step 20: Set the actuators to be driven by table-based data curves   

• Double-click the arrow for the Bucket actuator to select the actuator and bring up its microdialog.   

• Change the profile type to Table.  

 

 

•  Click the Edit the Table Profile button          to enter the Profile Editor  

• In the Profile Editor, click the Load Data icon             Navigate to and load the file  
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Bucket_Actuator-Travel_Plot.csv.  

 

Tip: The file is read and populated into the Profile Editor for review and editing.   

• Close the Profile Editor and deselect the actuator.   

• Similarly, edit the following actuators to use the following data tables:  

  

Actuator   Data File   

Bucket   Bucket_Actuator-Travel_Plot.csv   

Boom   Boom_Actuator-Travel_Plot.csv   

Boom   Boom_Actuator-Travel_Plot.csv   

Ext Boom   
Extended_Boom_Actuator- 

Travel_Plot.csv   

  

• Exit the Actuators tool.   

 

Step 21: Set the Run Analysis options to end the simulation in 18 seconds and set the output rate to 100 frames per second   
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Step 22: Run the analysis   

Step 23: Review the motion animation by clicking and dragging the animation slider  

 

 

  

Step 24: Plot the joint forces and angular displacement of the pin between the boom and extended boom by clicking on the 

pin of interest   

  

Tip: Right-click on the plot to change the plotted data  
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Step 25: Export the joint forces on the pin between the boom and extended boom to a csv file named BoomJointForces.csv 

by right-clicking anywhere on the plot  

 

  

Step 26: Determine the force required to operate the bucket actuator by clicking on the actuator icon to get a plot  
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Step 27: Add a mass load to the bucket  

• In the Structure ribbon enter the Masses tool   

• Rotate the model so that the point in the middle of the Bucket can be seen. Hover so that the point crosshairs 

are highlighted and click on that point to create the point mass.   

• In the microdialog, update the point mass value to 1000 kg.  

 

• Click on the Connect Concentrated Mass button  in the microdialog.  

Tip: The cursor now shows a line connecting the point mass with the cursor.   

• Holding Shift, select the seven major interior faces of the Bucket as shown.  
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• Ensure that the microdialog for the connections shows Rigid and hit Esc to exit the Masses tool.   

  

Step 28: Rerun the analysis and replot the results from the joint pin and actuator as seen above   

Step 29: Create a tracer using the point of one of the bucket teeth as a trace point  
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11.6 Exercise: Motorcycle Suspension  

This exercise covers many basic features of Inspire Motion, such as navigating the interface, adding joints, adding a spring, 

adding an actuator, plotting results, analysing for stress and deflection using dynamic motion loads, and exporting a model 

from Inspire Motion to MotionView.   

This exercise shows how to build and analyse a basic model in Inspire Motion and move the model into MotionView for more 

advanced simulation options.   

The example we will use in this training exercise is a simplified motorcycle suspension. The objective is to simulate input to 

the mechanism using displacement vs. time data taken from physical test measurements and, with a given spring rate and 

damping rate, determine the maximum loads on the pins and the stress and deflection resulting in the bracket.  

Model File:  

https://altairuniversity.com/wp-content/uploads/2018/03/Motorcycle.zip   

 

 

Step 1: Load the Model   

• Start Altair Inspire   

• When Inspire has loaded, select File > Open. The Open File dialog appears.   

• Browse for and open the file called Shock_Assembly.stmod.    

Tip: Note that many other formats that can be read by Inspire Motion.  
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Step 2: Review Inspire mouse controls settings and set model and display units to IPS Std   

• From the File menu, select Preferences….   

• Click the section Mouse Controls. Update the setting, if necessary, to your settings of choice.   

• Click the section Units. Set the Model units to IPS Std (in pounds lbf s) and set the Display units to IPS Std (in 

pounds lbf s).   

• Click OK to exit the Preferences dialog box.   

Tip: Through mouse control settings, Inspire can be updated to use the same graphics area view pan, rotation, and zoom 

options as MotionView, HyperMesh, HyperView and the rest of the HyperWorks suite of tools.   

  

Step 3: Simulate the Model   

Tip: At the moment, there are no constraints in the model. By default, gravity is turned on and is the only boundary condition 

acting on the assembly. It is good to simulate the model periodically throughout the model building process to verify your 

connections are being defined properly as you work along.  

• 1.  Select the Play button within the Analyze Motion icon   located on the ribbon bar.   

Tip: Notice the assembly is floating off to the right side of the screen? This is because of the direction of gravity.   

Tip: To playback animation results, click, hold and drag the slider button on the animation playback bar which is located by 

default at the bottom of the screen.  
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Step 4: Redefine the Gravity vector   

• Click on the Gravity icon   on the ribbon bar   

• In the microdialog, click on Y to change gravity to act in the negative Y-direction.  

 

Step 5: Create Rigid Groups   

Next, we will begin by simplifying the model by grouping parts that have no relative movement between them. We will create 

(3) rigid groups.   

• Click on the Rigid Groups icon   on the ribbon bar.   

• In the model window, select the Housing, Collar, and Adjuster parts and click on  

• Create New Group  
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• With the Rigid Groups command selection still active, create groups for the following:   

o Piston/ Spacer 1 

o Link/ Spacer 3 
 

 

                                        Piston / Spacer 1                                     Link / Spacer 3 

 

Tip: The Rigid Group assignments above do not necessarily have to be organized exactly as they are specified here. For 

example, we could have attached the Spacers to the Brackets. How the parts are grouped will also help determine how 

features are detected when defining joints.   

  

Step 6: Create Joints   

• Click the Joints icon   on the ribbon bar.   

Tip: You will observe two things after doing this   
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• Four cylindrical face pairs are highlighted in red. These geometric feature pairs were detected based on default 

search criteria settings and are now candidates for joint types and locations.   

• A number, in this case (4), appears above the Joints ribbon icon, indicating the number of pairs detected.   

 

• Create the joints in one of the following ways:   

o Left mouse-click on a (red highlighted) detected pair (this creates the joints one-byone)   

o Select the Connect All button on the search settings guidebar (this creates all four joints at the same 

time)   

 

 

Tip: The model should now appear as shown below. Also notice the four joint objects in the browser:   
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• On the guidebar, select the All button                                        and change the filter type to Single Holes. Two 

holes are highlighted.  
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• To finish creating the joints, either simply left-click on the (red) highlighted feature pairs or choose Connect All 

from the guidebar   

Tip: Notice the cone-shaped graphics that appear on the ends of each pin graphic, representing it being connected to 

ground.   

  

Step 7: Add a spring to the model   

• Hide the housing by selecting the housing graphic or the Housing feature name in the Model Browser and 

pressing the H key on the keyboard. Alternatively, the visibility can be toggled by clicking on the graphic 

visibility icon next to the Housing in the Model Browser.   

 

• Click on the springs icon  on the ribbon bar.  

• To define the first endpoint of the spring, hover the mouse over the area near the center of the Adjuster as 

shown until the mouse cursor reads Cen and left-click. Similarly, define the second endpoint of the spring this 

time using the center snap point of the bottom of the Piston.   

 

Tip: A spring/damper graphic is created. The free length (Lf) shown in the spring microdialog should read ~ 5.00 in   
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• Change the stiffness K to 65 lbf/in, damping coefficient C to 12 lbf*s/in, and preload Fi to 125 lbf.   

Tip: Notice that the free length (Lf) automatically changes to ~6.9 in.   

 

• Select, hold and drag the move arrow near the center of the spring to resize the spring to any desired 

diameter.   

 

 

 

 

 

 

 

 

 

 

 

Tip: Take notice of the red vector arrows stemming from the spring endpoints. These graphics indicate the spring is currently 

in compression, as it is exerting an outward push against the objects compressing it.   

 

Step 8: Define Actuator and Input   

We will create an actuator that will represent the input (displacement vs. time) coming from the rear axle frame (not 

physically included in the simulation model). We will use physical test data measurements (spreadsheet table) to drive the 

actuator.   
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• Select the Actuators icon   located on the ribbon bar.    

• On the guidebar, set the filter type to Features   

 

• Hover the mouse over Spacer 2 and select the center snap point.   

 

  

• Click on the (red) highlighted face of the spacer to connect the actuator to ground   

 

   

Tip: The model should now appear as follows. The default actuator type is a Displacement actuator.   
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With the new actuator selected, click on the chevron on the microdialog and select the Move icon. Click on the X-rotation 

arc.   

 

• To rotate the actuator to a precise position of sixty degrees, either 1) enter 60 deg in the value field or 2) hold 

and drag the rotate arrow to re-orient the actuator to 60 deg.   

 

         

• Press the ESC key to exit the move command.   

• Right-click the new actuator listing in the Model Browser and select Properties from the context-sensitive 

menu.   

• In the Property Editor, enable the option to Maintain Coaxiality.   
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• In the Inspire Preferences menu, change the units to MKS (m kg N s).  Tip: The Inspire Motion material on 

Using Table Data provides an explanation on why we are temporarily switching unit types.   

 

• Click on the actuator graphic access the microdialog. Change the Function type from Step-Dwell-Step    

to Table   

• Click the Edit the Table Profile button   

• When the Profile Editor opens, click the Open File button  , browse for, and select the file    

Tip: Note the beginning and end time of the imported data.   

    

  

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  373   

 

 

• Change the Inspire Unit back to IPS Std  

 

 

Step 9: Modify the Simulation Run Time   

• Click the Run Settings button   next to the Analyze Motion icon to open the Analysis settings dialog.   

• Change the End Time to 2 s and set the Output Rate to 100   

• Click Run   to run the simulation.   

  

Step 10: Plot the Results   

Tip: Plots of results within Inspire can be created by simply left mouse-clicking on any model object (part, joint, actuator, 

spring, etc.) either in the browser or in the graphics area. To change the plot result type, right-click anywhere on the plot.   

• Click on the various pins to see plots of the normal forces acting on them.   
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• Click on the actuator to show a plot and set the plot type to Travel (displacement vs. time profile).   

 

Tip: Note that the profile matches the spline curve profile we imported into the model.   

• Right-click anywhere on the actuator plot and choose Acceleration.   
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Step 11: Analyse Bracket for Stress and Deflection   

Inspire Motion is tightly integrated with other Inspire functionality, such the ability to modify, add and remove geometry, solve 

for stress and deflection and run a topology optimization. In the next step, we will have Inspire Motion automatically apply 

the resulting forces from the motion analysis as boundary condition inputs for a linearstatic structural analysis on the 

Bracket. The analysis may take ~ 8 minutes to complete.   

• Select the Bracket LH part and click on the Analyse Part button  .   

 

• In the Run Analysis dialog that appears, under the Loads from Motion section, select the option to Use all 200 

time samples.   
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• Click Run to begin the analysis.   

• After the run is complete, view the results. Request the von Mises Stress and select the animation play button. 

This will animate the motion and stress together.    

 

• Re-contour the part to show the displacement result and run the motion animation again.  
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11.7 Exercise: Pully Extension  

This exercise covers advanced features of Altair Inspire mainly Motion Contact.  

Model file: https://altairuniversity.com/wpcontent/uploads/2019/04/Pulley_Extension_start.zip   

 

 

Step 1: Select Pulley Segments parts and assign Aluminium as material  

• Start Altair Inspire   

• When Inspire has loaded, select File > Open. The Open File dialog appears.   

• Browse for and open the file called Pully_Extension_Start.stmod.    

• Tip: Note that many other formats that can be read by Inspire Motion.  

• In the Model Browser, select the parts named Pulley Segments  

• In the Property Editor, select the material Aluminium (2024-T3/T6/T8)  
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Step 2: Select Central Gear parts and assign Iron as material  

Tip: At the moment, there are no constraints in the model. By default, gravity is turned on and is the only boundary condition 

acting on the assembly. It is good to simulate the model periodically throughout the model building process to verify your 

connections are being defined properly as you work along.  

• In the Model Browser, select the part named Central Gear  

• In the Property Editor, select the material Iron (Alloy Cast)   
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Step 3: Right click on Base part and make it ground  

 

  

  

Step 4: Select Pulley Segments and Base parts and isolate them clicking I (Isolate) button on the keyboard  
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Step 5: Click on Joint Ribbon and Connect All to create joints between Pulley Segments and Base  

  

                

 

 

Step 6: Select the 5 joints created and change their type to Translational in the Property Editor  

 

   

   

http://altair.com/
https://www.altair.com/contact-us/


 

 eBook / Simulation-Driven Design with Altair Inspire 

 

 © Altair Engineering, Inc. All Rights Reserved.  /  altair.com  /   Nasdaq: ALTR  /  Contact Us                                                                                                                  381   

 

Step 7: Right click to exit the Joint tool and click A on the keyboard to show all parts  

Step 8: Re-enter the Joints tool, change the Find option to Cylindrical Pairs, modify the type to Hinge and click Connect All. 

Right click to exit the Joint tool.  

 

 

  

Step 9: Isolate the Pinion Gear and Base  

Step 10:  Enter the Motors tool. Select the center of the post supporting the Pinion Gear to set the motor shaft 

location. Click on the surface face to set the base.  

 

  

Step 11: Set the motor type to Angle and the profile to Oscillating. Use the Profile Editor to set the following parameters for 

the Oscillating Profile:  
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• Span: 1s  

• Phase Shift: 30 deg  

• Average Value: 90 deg  

• End Time: 1s  

          

  

Step 12: Show all parts  

Step 13: Enter the Contacts Tool   

• Change the selection method to By Material.  

• Select any Pulley Segment part.  

• Click on Parts 2 and select Central Gear.  

• Check the Individualize box and click on Create.  
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Step 14: Change the selection method to By Parts  

• Select the Pinion Gear part.  

• Click on Parts 2 and select Central Gear.  

• Click on Create.  
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Step 15: Right click to exit the Contacts tool and Run the model.   

Step 16: Animate the model using the animation bar.   

  

 

 

 

 

 

 

 

11.8 Debugging Inspire Motion  

• Crawl-Walk-Run: Start simple, save and solve often. This simplifies figuring out what went wrong between 

analyses  

• Create temporary Rigid Groups to freeze joints between parts in order to debug a specific set of relative motion  

• Use the ground tool to temporarily ground parts to focus on a specific part/joint  

• Lock motors or actuators to prevent rotation and verify the motions of connected parts or joints.  

Alerts occur when a problem has been detected with a model. Buttons within the alert may offer the following functions:  

• Review: Review/Fix the modeling issue  
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• Help: Launch Help to find a resolution  
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When requesting a motion analysis, Inspire checks the model for conflicts. Several types of issues may be found. Below is a 

summary of common issues and resolutions for those issues: 

 

  

Issue  Resolution  

Model contains no active 

parts  
Import parts or use the geometry ribbon to create parts within the model  

All parts are grounded  
Use the Ground tool to unground the part or at least one part in a rigid 

group  

Massless parts detected  
Deactivate or Delete the Massless parts, organize them into rigid groups 

with parts that have mass or use the Property Editor to update the mass  

Directional conflict in  

Torsion Spring  There may have been a possibility that the spring or motor was created 

by clicking the same part twice, in which case the spring or motor must 

be deleted or carefully recreated by selecting two different parts. 

Alternatively, attempt restraining the axis of the spring or  

motor using the Restrain Centreline Property  Directional conflict in 

Motor 

Motor or Actuator joint is 

locked 

Use the Property Editor or right-click in the motor or actuator and use 

the context-sensitive menu to unlock the motor or actuator 

Parts defining torsion 

springs are grounded 
Click the Fix button to Unground the relevant Part 

Coli Spring dimensions 

are not realistic 

Decrease the wire diameter or number of Coils in the spring or use the 

endpoint manipulator to alter the spring length. 
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11.9 Inspire Motion and MotionView Integration  

Inspire Motion can export MDL-compatible models for use with MotionView software. Inspire Motion uses MotionSolve as its 

solver. When exporting from Inspire Motion to MotionView, users have access to extended functionality in a motion solution 

that is not available through the Inspire toolset.   

Models in Inspire can be exported to MotionView using the Export button in the Run Motion Analysis dialog window:  

Prior to export, set the Model Units (Preferences page) to the desired type. The model representation is converted to a 

MotionView equivalent. MotionView output requests are created automatically for each defined feature in the Inspire Motion 

model. The Rigid groups are considered one body in MotionView. The Ground parts are considered as part of the "Ground 

Body" in MotionView. 

 

  

  

Joint Specification  

If you want all joints to be rigid in the MotionView export, you must change joint specifications in Inspire Motion. Using the 

Run Motion Analysis window, enter the Advanced settings. 

Set both Joint behavior and Joint patch behavior to Rigid.  

Alternatively, if selecting individual joints to be rigid, change the joint Behavior to Rigid using the Property Editor.  

When making these changes to the model, rerun the Motion Analysis to verify that the model runs as expected prior to 

export. All panel options such as end time, output rate, etc. are sent to MotionView as solver settings.  
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11.10 Inspire Motion and Altair Activate Integration  

 Motors and Actuators have a built-in controller which can be enabled or disabled. The plant model can be exported for 

external control with a product like Altair Activate.  

To prepare a model for plant export:  

• Determine which motors/actuators to include in the plant export  

• Enable PID controller option for those motors/actuators •  Confirm that Provide Signals to Plant option is 

enabled as shown  

• Export the model in MDL format.  
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   12.  Tips and Tricks  
 

Quickly create individual “parts” for several solids.  Learn More …  

You can now move the sketch plane to required position and orientation.  Learn More …  

Washer/bushing creation to avoid applying loads or boundary conditions on design 

space  Learn More …  

An introduction to output files  Learn More …  

Fully capture and identify load paths and material distribution in a typical analysis.  

Learn More …  

A rule-of-thumb when manually gauging what min thickness to apply to the analysis 

to fully capture the problem setup.  Learn More …  

Easily navigate through a sketch or assembly with the snap features.  Learn More …  

Hotkeys for quickly navigating through various features within Inspire.  Learn More …  

Different methods of making parts transparent for ease of viewing internal 

structures.  Learn More …  

Changing the colors of parts or loads to make them easier to distinguish in large 

models.  Learn More …  

Identifying the mass of parts and assemblies in the model tree.  Learn More …  

Achieve the most accurate results when running a minimize mass and maximize 

stiffness optimization.  Learn More …  

Changing the number of CPUs to 4 for reduction of optimization computing time  

Learn More …  

Clearing the run history folder of all the optimization results files.  Learn More …  

Selecting English units for an analysis at any point during the analysis setup  
Learn More …  

Optimization using unit orthogonal forces when actual loading is unknown  Learn More …  
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Several options for organizing optimization results creating smaller .stmod files  

Learn More …  

Isolate components within an assembly for analysis  Learn More …  
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13. How to Interpret Finite Element Analysis Results  
   

Let us look at the results obtained after analysis, our intention to do the analysis in some detail.   

  

Displacement   

It is important to check displacements for general analysis to understand the deformation of the structure for the loads 

applied,   

For static analysis, it is important to check the following for each load case being considered:   

• Correct Order of Magnitude: Are the displacements of the correct size? If a component 100 mm long has a 

displacement of 1000 mm this will indicate incorrect load magnitudes or inappropriate supports. It can also 

indicate incorrect material properties.   

• Shape of Deformation: By animating the model for each load it is possible to ensure the structure is deflecting 

in a logical way. Unusual behavior is usually found to be the result of incorrectly applied loads and/or supports.   

   

Factor of Safety   

The Factor of Safety is calculated by looking at the stress in each part and comparing it with the yield stress (as defined in 

the material properties) for that part.   

Factor of Safety (F.S.) = yield stress / calculated stress F.S. < 1.0 (or near 1.0) will show as RED indicating likely regions 

of failure.   

The larger the F.S. the less likely a part is to fail.   

An accurate F.S. depends on accurate loadings and accurate material and analysis models.   

There is no definitive factor of safety that is suitable for all applications   

 

Percent of Yield   

Percent of yield is essentially the inverse of Factor of Safety expressed as a percentage.   

  Percent of yield = (calculated stress / yield stress) x 100  The yield is obtained from the material properties.   

% Yield > 100% (or near 100%) will show as RED indicating likely regions of failure.   

The lower the % Yield the less likely a part is to fail.   

  

Tension and Compression shows the user which areas of the model are in tension, and which areas are in compression. 

These results are derived from the von Mises Stress results   

  

Maximum Shear Stress shows the user failure in shear   
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Von Mises failure criterion   

The von Mises failure criterion is typically used to assess the structural performance of ductile materials.   

A material is said to start yielding –which in many instances is considered failure – when the von Mises stress reaches the 

yield stress.    

    

The equation can be represented in the 2D case by the ellipse shown below.    

  

 

 

 

Major Principal Stress   

The Major Principal Stress – also known as the normal stress, Coulomb, or Rankine criterion – is often used to predict the 

failure of brittle materials.   

The Major Principal Stress states that failure occurs when the maximum (normal) principal stress reaches either the uniaxial 

tension strength st, or the uniaxial compression strength sc,    

Compared with the von Mises criterion, the Major Principal Stress criterion be a no conservative approach if applied to 

ductile materials.    
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Natural Frequencies   

For modal analysis, it is important to check if the natural frequencies are reasonable. The natural frequencies for each 

normal mode is displayed under result type.   For a free vibration analysis (no supports) all parts of the model will be in 

motion and coherent – no parts will move independently of other parts.   

If supports are used then those areas should move as per their constraints (fixed, slide, etc.)   
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14. CAD Sketching with Evolve  
 

You may be interested to learn more about the CAD/sketching functionalities available in Evolve.   

For a jump start using EVOLVE we recommended the eLearning course   

“Learn 3D Modeling with Evolve”  

available in the Learning & Certification Program.  

In the aforementioned Capstone Project - The Virtual Bike Project, we started sketching our ideas about the bike from 

scratch.   

 

http://certification.altairuniversity.com/course/view.php?id=86   

  

 

Objective:   

Sketch/draw the geometry of the 3-wheeler bike used in the Capstone Project: The Virtual Bike Project”.  

  

View project related recordings  

(by Christian Bohnenberger - a first-year student at Altair Germany, 2016):  

https://altairuniversity.com/conceptual-design-of-a-3-wheeler-motorbike/three-wheeler-bike-sketching-first-ideas-

solidthinking-evolve-2/  

Enjoy sketching your own ideas - and don’t miss to share your results!  
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15. Get Certified  
 

Provided you carefully studied this guide you should be able to pass our Inspire Certification course:  

https://certification.altairuniversity.com/course/index.php?categoryid=23  

You will be required to score 80% of the total marks in each quiz, to complete the Examination and receive the certificate, 

also note that you are allowed only 3 attempts in each quiz, so if unsuccessful in your first attempt, you should review the 

learning course or this study guide again, read the questions more carefully and try do better in the next two attempts, your 

highest score among all 3 attempts will be considered and if the score is below 80% in all three attempts you cannot 

complete the examination.  

In case this happens please send a mail to altairuniversity@altair.com asking to reset your attempts.  

  

The examination consists of different kind of questions only. Some questions are rather easy to answer,  

 

  

others are more challenging  

 

  

or drag and drop the correct word (answer) into the respective blank field. 
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      And finally – please let us know whether this guide helped you. Send a quick note to     

altairuniversity@altair.com 

 

                         THANK YOU very much for your feedback 

 

Your Altair University Team 
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